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About the AED COP 
In October 2012, subject matter experts from several federal agencies developed an Accessible 
Electronic Document Community of Practice (AED COP). The following goals were set: 

• Increase awareness of the importance of access to Accessible Electronic Documents across 
the federal community. 

• Promote successful strategies which increase the ability of federal employees to create 
accessible electronic documents. 

• Advance the field of accessibility for all participating agencies by creating a repository of 
accessibility artifacts. 

• Identify and improve the alignment of requirements defining accessible electronic documents 
across for all participating agencies. 

• Promote successful strategies which create the highest level of accessibility for documents at 
the lowest cost. 

• Identify and supply best practices to the CIO Council Accessibility Committee Best Practices 
Subcommittee.1 

The result of the collaboration between agencies is reflected in the current document, and 
associated documents: 

Associated Documents from the AED COP 
• Baseline Tests for Accessibility—The Baseline Tests represent interagency agreement on 

what to test and how to test. The Baseline Tests are a set of individual requirements and test 
steps for Section 508 conformance. The Baseline Tests do not make up a ‘test process’ per 
se; instead, conformance test processes and authoring guidance is created from the Baseline 
Tests. 
• MS Word  
• MS PowerPoint 
• MS Excel 
• PDF (Portable Document Format) (the current document) 

• Section 508 Conformance Test Process—for use by Section 508 testers, these documents 
contain only the necessary information for conducting a test of an already-authored, already-
formatted document. 
• MS Word 
• MS PowerPoint 
• MS Excel 
• PDF (Portable Document Format) 

• Authoring guides—for people who are authoring documents (creating content and 
formatting). Contains guidance on creating accessible documents from scratch, and guidance 
on how to test a document for conformance with the Baseline requirements. 
• MS Word  
• MS PowerPoint 
• MS Excel  

                                                 
1 The Accessibility Committee serves as the principal interagency forum to improve the Federal 

government’s implementation of Section 508. See https://www.cio.gov/about/committees-
affliates/accessibility-cop/. 

https://www.cio.gov/about/committees-affliates/accessibility-cop/
https://www.cio.gov/about/committees-affliates/accessibility-cop/
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Document status, review comments, and feedback 
The current version 1.1 is approved for distribution by the AED COP. Please visit 
www.section508.gov\refresh-toolkit. 

http://www.section508.gov/refresh-toolkit
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Introduction 
Baseline Tests 
This document contains baseline tests (tests) which establish the minimum steps required to 
determine whether an electronic document produced in PDF2 passes or fails Section 508 
requirements. These tests have been agreed upon by the Accessible Electronic Document 
Community of Practice (AED COP) and while each agency maintains responsibility for 
determining 1) if additional tests are necessary and 2) if test outcomes result in an accepted 
document, members have agreed that these tests are the minimum steps necessary to determine 
conformance. 

This document is intended for people who create test processes for federal agencies and is not 
intended for end-users. However, this document does contain information that may be used to 
create resources for end-users such as requirements, user-guides, contract language and training 
materials etc. 

The tests have been agreed upon as part of an effort to provide a unified approach for Section 
508 testing, to increase consistency across government, and to build confidence in test results 
shared between agencies. The tests include: 

• General requirements, rationale and related standards that pertain to all electronic 
documents, 

• Test steps and failure conditions for published PDF documents, and 
• Tips for developing a streamlined test process. 
Agencies are encouraged to adopt the tests, to create additional resources using the baseline, 
and to incorporate additional agency-specific test criteria if necessary. 

At the time of writing this document, the original section 508 requirements were still in use.  Tthe 
revised standards follows closely the World Wide Web Consortium (W3C) Web Content 
Accessibility Guidelines 2.0 (WCAG 2.0).3 Therefore, these tests also include, or at least align 
with4 most of the WCAG 2.0 Level A and Level AA success criteria. A cross reference mapping 
the tests to Section 508 and to WCAG 2.0 standards is provided in Attachment A - Cross-
Reference Tables starting on page 68. 

                                                 
2 The tests concern the accessibility of electronic documents published internally or externally by an 

agency and do not pertain to draft or throw-away documents. 
3 Web Content Accessibility Guidelines (WCAG) 2.0, W3C Recommendation 11 December 2008. 

Available: http://www.w3.org/TR/WCAG20/ 
4 Note that "aligns with" does not imply "conforms to". For conformance with WCAG 2.0, a WCAG 2.0 test 

process should be followed. 

http://www.w3.org/TR/WCAG20/
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Background 
In October 2012, subject matter experts from several federal agencies developed an AED COP 
and the following goals were set: 

• Increase awareness of the importance of access to accessible electronic documents across 
the federal community. 

• Promote successful strategies which increase the ability of federal employees to create 
accessible electronic documents. 

• Advance the field of accessibility for all participating agencies by creating a repository of 
accessibility artifacts. 

• Identify and improve the alignment for the definition of requirements for accessible electronic 
documents across federal government for all participating agencies. 

• Promote successful strategies which create the highest level of accessibility for documents at 
the lowest cost. 

• Identify and supply best practices to the CIO Council Accessibility Committee Best Practices 
Subcommittee.5 

While all federal agencies are required to publish accessible electronic documents, agencies have 
different accessibility requirements. Inconsistency causes the following problems: 1) frustration 
for citizens and federal employees seeking information, 2) confusion for vendors producing 
accessible documents shared across the federal government and applying different requirements 
to meet the same legal standards, and 3) inability of agencies to easily reuse accessibility 
artifacts. 

In an effort to improve Section 508 testing for electronic documents across government, the 
harmonized baseline test process has been developed as part of a collaborative project by subject 
matter experts from the following agencies: 

• Consumer Finance Protection Bureau (CFPB)  
• Department of Defense (DOD) 
• Department of Education (ED) 
• Department of Health and Human Services (HHS) 
• Department of Homeland Security (DHS) 
• Department of Justice (DOJ) 
• Department of State 
• Department of Transportation (DOT) 
• Department of Veterans Affairs (VA) 
• Federal Reserve Board (FRB) 
• Internal Revenue Service (IRS) 
• National Aeronautical Space Administration (NASA) 
• National Archives and Records Administration (NARA) 
• National Institute of Health (NIH) 
• Social Security Administration (SSA) 
• US Access Board 

                                                 
5 The Accessibility Committee serves as the principal interagency forum to improve the Federal 

government’s implementation of Section 508. See https://www.cio.gov/about/committees-
affliates/accessibility-cop/. 

https://www.cio.gov/about/committees-affliates/accessibility-cop/
https://www.cio.gov/about/committees-affliates/accessibility-cop/
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In addition, tests align to WCAG 2.0 as AED COP members anticipate technology changes. Since 
the W3C has high-level guidance on applying WCAG to non-web content ICT6 the tests 
emphasize methods and techniques that increase consistency of results and reduce ambiguity. 

This document contains a set of tests that cover Section 508 standards and align with applicable 
WCAG 2.0 Level AA success criteria. These tests can be incorporated in distinct, practical, and 
systematic processes for PDF documents. Additional WCAG 2.0 harmonization may be 
investigated as the Section 508 refresh, software and testing tools advance. 

Test Composition 
The criteria for requirements and tests included: 

• Derivable: The requirements were derived from 508 Standards and addressed specific, 
documented, high-risk accessibility issues such as complaints. 

• Testable: Tests were validated by AED COP members and produced reliable and repeatable 
results. 

• Repeatable: Individual tests contained sufficient information and instruction to make a 
consistent and unambiguous measurement independent of other tests. 

• Usable: Usability testing was performed on validated tests. 

Application 
The tests have been established using Adobe Acrobat XI and Acrobat DC Professional running 
on the Microsoft Windows operating system. Some PDF viewers such as Adobe Reader support 
accessibility; however, tests can only be verified with a dedicated testing tool such as Adobe 
Acrobat Professional. While there are other third party tools for PDF remediation, Adobe 
Acrobat XI and Acrobat DC Professional have been validated. Agencies that use different 
versions of Acrobat or other third party tools are encouraged to develop an equivalent process 
for their test environments. Contact the AED COP representatives (see contact details at the 
front of this document) with additional test processes which may be adopted and shared once 
the results have been verified. 

Baseline Tests 
There are 23 distinct requirements with associated tests. Each test contains the following 
information: 

Generic to all electronic documents: 
• Numbered Requirement: How the component(s) should function in order to meet the related 

standards. 
• Rationale: An explanation of the elements/components the requirement is addressing 

(technical aspect in layman’s terms), effects on accessibility, consequences of incorrect 
implementation on accessibility (AT functionality), and the benefits of correct implementation. 

• Related Standards: Applicable Section 508 standards and alignment with relevant WCAG 
2.0 success criteria. Note: A 508 standard or WCAG criteria may be addressed by multiple 
tests.7 

Specific to PDF documents: 
• Tools Necessary: Navigation panes, dialog boxes, etc. used in the test. 
• Test Instruction 1 - Finding Applicable Components: 

• Test Instruction 1a: Manual Find of Applicable Components: How a tester would 
manually find the document element that needs to be tested. 

                                                 
6 See http://www.w3.org/TR/wcag2ict/. 
7 Cross-reference tables are provided in Attachment A. 

http://www.w3.org/TR/wcag2ict/
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• Test Instruction 1b: Accessibility Full Check Find of Applicable Components: How a 
tester would find the document element that needs to be tested, using the built in 
Accessibility Full Check (where available).8 

• Test Instruction 2 - Inspecting/Using Components: 
• Test Instruction 2a: Manual check for Inspecting/Using Components: How a tester would 

determine whether the element found in instruction 1a or 1b meets the requirement. 
• Test Instruction 2b: Accessibility Full Check for Inspecting/Using Components: How a 

tester would determine whether the components found in instruction 1b meet the 
requirement. 

• Test Instruction 3 - Failure conditions: A list of possible outcomes from instruction 2 and 
what to report. 
• 3a – Section 508 Failure Conditions: The technical requirement and/or functional 

performance criteria that should be marked as failures in test results. 
• 3b - WCAG2 Failure Conditions: The A or AA criteria that should be marked as failures 

in test results. 
• 3c - Baseline Requirement Test Results: A Summary of pass and not applicable 

conditions for each requirement. Note that any failure in 3a means that the baseline 
requirement fails.9 

Each test contains "Tips to enhance and streamline test processes" that provide helpful 
information about combining or enhancing tests. Again, it is not recommended to do all the tests 
in sequence, as they are listed in an arbitrary fashion. Rather, users are encouraged to develop 
the streamlined test process that bests suits their agency from this baseline. 

Use of Tests by Federal Agencies and Other Groups 
Federal agencies and other groups are encouraged to adopt these tests (and may develop 
additional tests if necessary). In addition, the AED COP developed a recommended test process 
and agencies are encouraged to review the test document for reuse prior to developing a new 
document.10 

To comply with the baseline, agencies MUST: 

• Incorporate each baseline requirement into their test process and report results when sharing 
documents. 

• Report clearly and separately tests that are agency specific. 
Test processes that do not include all baseline requirements are not considered in conformance 
and should not be promoted as such by agencies. 

Baseline Assumptions and Disclosures 
The tests are only part of a comprehensive Section 508 program. Additional contextual issues to 
consider include: 

• This document does not address policies or processes necessary to develop a Section 508 
program. 

                                                 
8 The Adobe Acrobat XI and Acrobat DC Professional Accessibility Full Check does not check all Baseline 

requirements.  Where there are related tests, these tests are not always reliable.  
Therefore, when the Accessibility Full Check is not available or is not reliable, then manual checks must 
be used in test instructions 1a and 2a. 

9 Test results 3a and 3c must be reported when sharing documents between agencies. 
10 The baseline tests should not be modified and should be properly cited when being re-published. 
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• This document does not include criteria for acceptance of vendor deliverables. However, test 
results can assist in acceptance decisions of contract deliverables. The results may be used 
to notify vendors or others of defects and help the vendor with planning and/or remediation. 
This document does not address remediation. While the correct method for formatting may 
be inferred from the test processes, that is not the intention of the test processes as they are 
written. 

• This document does not address editing errors such as links that lead to the wrong target 
website, inconsistent use of styles, or editing comments embedded as hidden text). 

• The test methodology does not include tests with assistive technology (AT). Agencies must 
decide the role assistive technology plays in testing accessible electronic documents. 
Because AT testing can result in false-positives and false-negatives, defects must always be 
confirmed with the corresponding baseline tests. Additional testing with AT may reveal 
conclusive insights, but caution is urged as AT testing is effective only with experienced, well-
trained testers. 

• Test results can be regarded as one factor of a conformance determination; other factors 
include, but are not limited to: 1) legal issues related to acquisition,11 2) technical issues of 
compatibility with existing systems, and 3) business needs. 

• The tests harmonize requirements across several federal agencies; however, determination 
of conformance remains with the agency publishing the document. This determination 
flexibility allows agencies to move toward a harmonized process over time. However, this 
flexibility also creates risk if an agency publishes a document with a failed test. Therefore, 
agencies should carefully evaluate the risks associated with publishing documents that do not 
conform to the tests. 

                                                 
11 Federal Acquisition Regulation (FAR 39.2) https://www.acquisition.gov/far/html/Subpart%2039_2.html 

https://www.acquisition.gov/far/html/Subpart%2039_2.html


Baseline Tests for Accessible Electronic Documents—PDF (Portable Document Format) 

Page 10 

Developing a Streamlined Test Process from this 
Baseline—a Primer 
The following notes give a primer on issues to consider while developing a streamlined testing 
process. 

Examine Published Test Processes First 
The AED COP has published a recommended test process so consider using this first.  

Examine Advisory Notes 
Each test has a row entitled "Advisory: Tips to enhance or streamline test processes" These 
are helpful tips about how tests may be combined or enhanced, etc. 

Target Audiences, Requirements, and Test Instructions 
The tests have been written with the following assumptions about end-users or testers: 

• They have basic skills in accessibility and Adobe Acrobat Professional; 
• They have skills to evaluate subjective information in context such as the suitability of alternate 

text for images; and 
• They have proper documentation, test plans, demonstrations, and access to authors for 

clarifications and explanations as appropriate. 

Modifications to Tests 
Users are encouraged to adopt the tests and create a streamlined test process suitable for their 
agency. This development process might require some modification to the tests. The following 
guidance identifies what to do and what not to do when modifying baseline content. 

Include all tests 
Agencies agree to incorporate each test; deleting any test is not allowed. The following list is the 
minimum that must be adopted in order to comply with the tests: 

• Numbered Requirement 
• Test Instruction 1 - Finding Applicable Components 
• Test Instruction 2 - Inspecting/Using Components 
• Test Instruction 3a - Section 508 Failure Conditions 
• Test instruction 3c - Baseline Requirement Test Results 

Wording changes 
Changing words in the baseline is allowed when creating instructions for end-users or testers; 
however, users should be careful that the intended meaning remains. For example, "The distinct 
destination, function or purpose of links and user controls must be described in the link/control 
name or surrounding text" may be reworded to “Provide the distinct destination, function or 
purpose of links and user controls and describe this information in the link/control name or 
surrounding text” depending on the target audience. Also, additional instruction may be added to 
tests. For example, each test lists tool(s) used such as navigation panes, dialog boxes, etc. The 
tests provide high-level instruction regarding tool use but may include more detailed instruction. 
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Test order 
Tests are not intended to be performed in the order presented here and should be changed or 
combined for efficiency. For example, data table headers and cell-header association tests might 
be done at the same time or seldom used test information may be listed at the end. 

It is a best practice to test your source document in the authoring tool (such as MS Word or Adobe 
InDesign) prior to testing the PDF in Adobe Acrobat XI or Acrobat DC Professional. 

Additional agency-specific tests 
If necessary, agencies may modify test processes to include more than the baseline. For example, 
an agency may decide that "reports and memos over 1,500 words must include headings to 
enhance readability and accessibility". Therefore, the test becomes: 

• Are existing headings programmatically marked and 
• Do headings exist to break up text over 1,500 words long. 
When sharing test results with other agencies, the agency-specific test: 

• Must be clearly marked as a non-baseline test and 
• Must be included with the other baseline results. 

Testing preconditions 
The following preconditions must be placed at the beginning of any test process. 
Precondition A – Portfolio and attachments: A portfolio is a collection of files combined into 
one PDF folio. Attachments are files embedded into one PDF Document. Collections and 
attachments may include a wide variety of document and file types, such as PDF, HTML and 
MS Word. Each document type must be tested separately and with the appropriate test process. 
An HTML document is considered a web page and should be tested using appropriate web 
testing methods. The AED COP recommends using the DHS Trusted Tester process located at: 
http://www.dhs.gov/compliance-test-processes. 

Precondition B – Adobe LiveCycle: The accessibility of PDF documents generated from 
Adobe LiveCycle must be verified in LiveCycle. Prior to testing a PDF, check the PDF Producer 
in Document Properties (File > Properties > Description). If the PDF Producer is Adobe 
LiveCycle Designer, then this test process will not be sufficient. Until the AED COP publishes 
the Harmonized Processes for Section 508 Testing: Baseline Tests for Accessible Electronic 
Documents—Adobe LiveCycle testers should rely on user testing with assistive technologies. 

Precondition C – Scripts: The Accessibility Full Check will flag the presence of “Scripts “in a 
document. Adding programmed formatting to a document effectively turns it into a software 
application; therefore, this test process does not apply. Software applications should be tested 
using appropriate software testing methods. The AED COP recommends using the DHS 
Trusted Tester process located at: http://www.dhs.gov/compliance-test-processes. 

Precondition D – “Tagged PDF”: In order to perform the Baseline Tests, the document must 
be tagged. To check for “Tagged PDF”, open the Document Properties (File > Properties > 
Description) or run the Accessibility Full Check. If “Tagged PDF: No” is found in Document 
Properties or if “Tagged PDF” fails in the Accessibility Full Check, then the PDF is not tagged. 
Agencies should add guidance on handling untagged PDF documents as part of a testing 
precondition for any Test Process. 

Precondition E – Scanned Document; All or part of a PDF could be compiled from scanned 
pages (i.e. pictures of the original). Screen readers cannot infer meaning from just a picture. 

http://www.dhs.gov/compliance-test-processes
http://www.dhs.gov/compliance-test-processes
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Optical Character Recognition (OCR) software may be used to recognize images of text in the 
PDF. 
Because of software limitations, scanned documents require additional steps to ensure 
accessibility. If you need to distribute a scanned document, then first consult your agency’s 
scanned document policy. 
Equivalent Facilitation: Some agencies may be able to claim an Equivalent Facilitation (36 
CFR 1194.5) if they have deployed end user tools that accurately extract text from scanned 
images. When a project or an agency meet the criteria in 1194.5, these Baseline Tests can be 
ignored if documents are not intended to be shared between agencies. 
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Reporting Results 
Each test includes three test results: Section 508 result (3a), WCAG 2.0 result (3b), and baseline 
result (3c). The Section 508 result and the test result must always be reported. 

Wording used to report failures may differ from the baseline. For example, a failure currently in 
the baseline: 

All meaningful objects must have text describing their purpose or function. 

Fails 1194.22(a): Equivalent text descriptions 

could be written in a streamlined process as: 

Meaningful object not properly conveyed in alt-text. Fail 22a 

Failures must be explained in the report and typically will contain information such as: failure type, 
location, and supporting screen captures. Reports may also describe the peer review processes 
used. When sharing reports between agencies, a checklist should be included but the 
conformance determination is not required. 
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The Baseline Tests (#1 - #23) 
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1. Inline Elements 
Requirement 
[All Documents] 

1. Meaningful text and objects must be placed inline. 

Rationale 
[All Documents] 

 

…technical aspects Text and objects can be formatted in documents to be ‘inline’ or ‘floating’ / 
‘wrapping’. Inline text and objects can be accessed by moving the keyboard 
cursor from element to element. Floating objects can be placed in front or, 
behind, or wrapping around the inline objects but they cannot be reached 
via the keyboard cursor. 

…effects on 
accessibility 

AT relies on the keyboard cursor to move through text and objects. 
Therefore, AT users cannot access floating objects. 

…consequences Floating content such as images overlapping inline text or tables that are 
surrounded on all sides by continuous text are not accessible via the 
keyboard cursor and therefore not accessible to AT users. 

…benefits Placing meaningful text and objects inline means all document content can 
be read and accessed by those who rely on navigation via the keyboard 
cursor. 

…rationale Summary Summary: 
Text and objects can be formatted as inline or floating/wrapping. Floating 
text and objects are not accessible via the keyboard cursor and therefore 
not accessible to AT users. 

Related Standards 
[All Documents] 

508 1194.21 SW (a): Keyboard Accessibility 
508 1194.31 FPC (a): Use Without Vision 
508 1194.31 FPC (b): Use With Low Vision 
508 1194.31 FPC (f): Use With Physical Limitations 
WCAG2 1.3.1: Info and Relationships 
WCAG2 2.1.1: Keyboard 

Tools Necessary 
[PDF] 

N/A 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

N/A (See Advisory tips) 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

N/A (See Advisory tips) 
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Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

N/A (See Advisory tips) 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

N/A (See Advisory tips) 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Inline Elements is a concept specific to MS Office. 
o Not Applicable Baseline Requirement #1 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 
 

• In PDF, content is focusable by default (not tagged as Background). In 
order to prevent focus (skip over) a piece of content, the content must 
be set to Background (Artifact). The combination of the Precondition #3 
Tagged PDF, Test #2 Reading Order and all subsequent tests 
determine that all content that needs focus is tagged. 
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2. Reading Order 
Requirement 
[All Documents] 

2. The visual and/or Logical Reading Order of meaningful content must be 
programmatically maintained.  

Rationale 
[All Documents] 

 

…technical aspects When the placement of content uses formatting elements such as text in 
columns, call-outs, tables, images etc., an intended reading order is 
visually and/or logically apparent. Text and objects can be accessed by 
moving the keyboard cursor from element to element. The programmatic 
order in which the cursor moves depends on the placement of content. 

…effects on 
accessibility 

AT users rely on the keyboard cursor to move through text and objects. 

…consequences When the placement of objects causes the programmatic order to differ 
from the intended reading order, content may be read out of order and 
therefore not comprehensible.  

…benefits A match between the intended reading order and the programmatic order 
provides comparable access for AT users. 

…rationale Summary Summary: 
Text and objects must be placed so that there is a match between their 
intended and programmatic reading order 

Related Standards 
[All Documents] 

508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
508 1194.31(f): Use With Physical Limitations 
WCAG2 1.3.2: Meaningful Sequence 
WCAG2 2.4.3: Focus Order 

Tools Necessary 
[PDF] 

Tags Pane, Physical System Keyboard, Accessibility Full Check 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Examine the document for meaningful text and objects. 
b. Examine the document for decorative content. 
c. Examine the document for a visual/logical reading order. 
d. Examine the document for the presence of interactive elements (e.g. 

links, user controls, and form fields). 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

a. Run the Accessibility Full Check and look under Page Content: 
“Tagged content”, “Tagged multimedia”, and Forms: “Tagged form 
fields. 
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Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that all meaningful content is tagged and check that the 
programmatic reading order matches the visual/logical reading order. 

• Open the Tags Pane (View > Show/Hide > Navigation Panes > Tags) 
and expand the tags container to view the structure tags. 

• Turn on Highlight Content (Options > Highlight Content). 
• Select the first tag. 
• Highlighted content is tagged. 
• Use the arrow keys (up and down) to check the order of each item. 
b. Check that decorative and not meaningful content is set to Artifact. 
• Open the Tags Pane (View > Show/Hide > Navigation Panes > Tags. 
• Find Artifacts (Tags Pane > Options > Find > Artifacts > Search 

Document). 
c. Check that the tab order matches the visual/logical order of interactive 

elements (links, user controls and/or form fields). 
• Use the physical system keyboard to TAB through the document. 
• Check whether the tab order matches the visual/logical order of 

interactive elements found in step 1a. 
Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

a. If Page Content: “Tagged content”, “Tagged multimedia”, or Forms: 
“Tagged form fields” fails, then meaningful content is not tagged or 
decorative content is not set to Artifact. 

b. If Page Content: “Tagged content”, “Tagged multimedia”, and Forms: 
“Tagged form fields” passes, then perform manual check, 2a.b to verify 
that meaningful content is not set to Artifact.  

Note: 
• The Accessibility Full Check has a check for “Logical Reading Order,” 

which always needs a manual check. Perform the manual check, 2a.c 
to see whether the programmatic reading order matches the 
visual/logical reading order. 

• The Accessibility Full Check has a check for Page Content “Tagged 
annotations”, which fails if links are not correctly tagged (with the link 
text and object reference). If links are not correctly tagged, then the tab 
order may not match the visual/logical order. Perform the manual 
check, 2a.d to verify. 

• The Accessibility Full Check “Tab order” checks the “Tab order” setting 
in Page Properties. The check fails if the “Tab order” is unspecified in 
Page Properties but the Accessibility Full Check cannot determine 
whether the programmatic “Tab order” matches the visual/logical order. 
Perform the manual check, 2a.d to verify. 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Meaningful content is not tagged or is set to Artifact. 
o Fails 1194.31(a): Use Without Vision 
o Fails 1194.31 (b): Use With Low Vision 

• Decorative content is not set to Artifact. 
o Fails 1194.31(a): Use Without Vision 
o Fails 1194.31 (b): Use With Low Vision 

• The programmatic reading order does not match the visual/logical 
reading order. 
o Fails 1194.31(a): Use Without Vision 

• The tab order does not match the visual/logical reading order of 
interactive elements. 
o Fails 1194.31(a): Use Without Vision 
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Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Meaningful content is not tagged or is set to Artifact. 
o Fails 1.3.2: Meaningful Sequence 

• Decorative content is not set to Artifact. 
o Fails 1.3.2: Meaningful Sequence 

• The programmatic reading order does not match the visual/logical 
reading order. 
o Fails WCAG2 1.3.2: Meaningful Sequence 

• The tab order does not match the visual/logical reading order of 
interactive elements. 
o Fails WCAG2 1.3.2: Meaningful Sequence 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #2 

• All meaningful content is tagged and is not set to Artifact, decorative 
content is set to Artifact, and the programmatic reading and tab order 
match the visual/logical reading order. 
o Passes Baseline Requirement #2 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Decorative and redundant content should be set to Artifact so screen 
readers can skip over it.  

• The order pane and reading order tool are useful in remediation but are 
not accurate testing tools. 
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3. Document Title (Filename) 
Requirement 
[All Documents] 

3. The filename must identify the document or its purpose.  

Rationale 
[All Documents] 

 

…technical aspects In addition to being used to locate and open documents, filenames are also 
used when switching between documents and between applications during 
work tasks.  

…effects on 
accessibility 

Windows-based operating systems show thumbnail / preview images which 
speed up the task of locating and switching between files. For screen 
reader users, the preview is unavailable but the filename is.  

…consequences If the filename does not properly identify the document or its purpose (such 
as “Document 7”or“Directions”), people with disabilities have to expend 
extra time to open and read the file’s content to identify it.  

…benefits Having a filename that adequately identifies the document and its purpose 
(such as “Hiring Policy [Document 7])”; “Directions to AED-COP HQ”) helps 
provides comparable access during typical work tasks. 

…rationale Summary Summary: 
People with disabilities rely on a descriptive filename to locate, open and 
switch between documents and applications during work tasks.  

Related Standards 
[All Documents] 

508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG 2.4.2: Page Titled 

Tools Necessary 
[PDF] 

Document Properties  

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Look at the filename in Document Properties (File > Properties > 
Description > File). 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that the filename identifies the document or describes the 
purpose of the content.  

Test Instruction 2b: 
Automated Checker for 
Inspecting/Using 
Components 
[PDF] 

N/A 
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Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• The filename does not identify the document or its purpose.  
o Fails 508 1194.31(a): Use Without Vision 
o Fails 508 1194.31(b): Use With Low Vision 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• The filename does not identify the document or its purpose.  
o Fails WCAG 2.4.2: Page Titled 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #3 

• The filename identifies the document or its purpose.  
o Passes Baseline Requirement #3 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• The Accessibility Full Check for Document: “Title” checks whether the 
document “Title” set in Document Properties will display in the Windows 
Title Bar. While it is a good practice to set other relevant attributes and 
information fields (such as document title, author, subject matter, 
keywords / tags, etc.) in Document Properties, this check is beyond the 
Baseline Tests.  
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4. Headings 
Requirement 
[All Documents] 

4. Headings must be programmatically identified and match the visual 
outline level. 

Rationale 
[All Documents] 

 

…technical aspects Headings are used to aid content navigation in terms of locating required 
content, and determining the importance or hierarchy of content (such as 
major section, section, sub-section). In addition to visual text formatting 
(such as bold, italic, underline, or combinations), programmatic formatting 
can identify the presence of a heading and its outline level. 

…effects on 
accessibility 

Assistive technologies such as screen readers and voice dictation systems 
rely on programmatic formatting to navigate between headings ( for 
example, there is no way to automatically determine whether bold 
underlined text is a heading, or merely a point of emphasis). 

…consequences Without programmatic formatting of headings, a document containing many 
visually apparent headings appears to AT as a document containing no 
headings.  

…benefits Assigning programmatic formatting that includes both the presence of and 
the and outline level of headings provides comparable access in terms of 
the comprehensibility of the content. 
Notes: 
• The requirement should not be construed to require headings in place 

of headers in data tables. 
• This requirement does not mean that headings be added; it means that 

where headings are identifiable through visual formatting, they must be 
programmatically identified. 

• Any visual representations of heading level (e.g. major section, section, 
subsection) must be matched by the programmatic heading level (e.g. 
major section = level 1, section = level 2, sub-section = level 3).  

…rationale Summary Summary: 
Programmatic formatting provides AT a means to identify the presence of a 
heading and its outline level. 

Related Standards 
[All Documents] 

508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
508 1194.31(f): Use With Physical Limitations 
WCAG2 1.3.1: Info and Relationships 

Tools Necessary 
[PDF] 

Tags Pane 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find where formatting has been used to logically divide and structure 
the document. Visually identify where headings are used in a document 
through text formatting, use of white space, boxes or other visual 
separators. 
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Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check if visually apparent headings are programmatically identified. 
• Open the Tags Pane (View > Show/Hide > Navigation Panes > Tags).  
• Use the Selection tool to select headings identified in step 1a one at a 

time.  
• Find the corresponding tag (Tags Pane > Options > Find tag from 

selection). 
• Check whether the selected heading is tagged with a heading tag (<H1>, 

<H2>, <H3>, <H4>, <H5> or <H6>). 
b. If nonstandard PDF tags are used (such as <Heading1> or 

<MainHead>), then check if tags are mapped to the correct role.  
• Open the Role Map (Tags Pane >Options > Edit Role Map). 
• Expand Document Roles. 
• Check whether the nonstandard heading tags are mapped to standard 

PDF tags (<H1>, <H2>, <H3>, <H4>, <H5> or <H6>). 
c. Check whether programmatically identified heading levels indicated by 

the numbers in the heading tags (<H1>, <H2>, <H3>, <H4>, <H5>, or 
<H6>) match the visual outline level. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Visually apparent headings are not programmatically identified. 
o Fails 1194.31(a): Use Without Vision. 
o Fails 1194.31(b): Use With Low Vision. 
o Fails 1194.31(f): Use With Physical Limitations 

• Programmatically identified heading levels do not match the visual 
outline level. 
o Fails 1194.31(a): Use without vision. 
o Fails 1194.31(b): Use with low vision. 
o Fails 1194.31(f): Use With Physical Limitations 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Visually apparent headings are not programmatically identified. 
o Fails 1.3.1: Info and Relationships 

• Programmatically identified heading levels do not match the visual 
outline level. 
o Fails 1.3.1: Info and Relationships 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #4 

• Visually apparent headings are programmatically identified AND 
heading levels match the visual outline level. 
o Passes Baseline Requirement #4 

• There are no visually apparent headings. 
o Not applicable (Baseline Requirement #4) 
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Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• If a page appears to have logical separable sections, but there are no 
headings, it might be worth informing authors that identifying such 
sections through headings and adding heading text might be useful for 
all users. 

• Section headings are used to provide structure on a page, facilitating 
faster comprehension. However, some designers may use 
programmatic headings for non-heading purposes, such as text styling 
to call visual attention to content. Such uses deviate from the primary 
purpose of headings, which is to provide information on how the 
content on the page is structured. It might be worth informing designers 
that using programmatic heading for non-headings can cause confusion 
individuals with disabilities. 

• Examples may be helpful to illustrate headings that do and do not 
match their visual structure. 

• Mapping to the visual outline does not necessarily imply using a 
hierarchical structure (in the case where the author intentionally is not 
using a logical hierarchy). However, it might be worth informing authors 
that a logical hierarchy is a best practice. 

• The Accessibility Full Check for “Appropriate nesting” looks for skipped 
heading levels. This check is beyond the Baseline Tests. However, it 
might be worth informing authors that using a sequentially ordered 
hierarchy is a best practice. 

• The Accessibility Full Check checks for the presence of “Bookmarks.” 
Bookmarks may assist in navigation; however, they are not a substitute 
for Headings.  
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5. Section Language 
Requirement 
[All Documents] 

5. Sections that use language other than the default must be 
programmatically identified (except for proper names, technical terms, or 
foreign words that have become part of the vernacular). 

Rationale 
[All Documents] 

 

…technical aspects Passages or phrases can be programmatically marked as a specific 
language.  

…effects on 
accessibility 

Screen reading AT accesses the programmatic language setting to provide 
the appropriate pronunciation while speaking that section of the document. 

…consequences If the language is not programmatically set (for example, in an English 
language document a section is written in Spanish but the entire document 
is programmatically set as English), then the speech of the screen reader 
could be incomprehensible to a Spanish speaker. 

…benefits For multilingual documents, properly setting the appropriate language 
changes enables the content to be delivered as the author intended for 
screen reader users. 

…rationale Summary Summary: 
Sections can be marked as a specific language. Screen reader AT 
accesses the language setting to provide the appropriate pronunciation. 

Related Standards 
[All Documents] 

508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 3.1.2: Language of Parts 

Tools Necessary 
[PDF] 

Tags Pane 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Identify the intended and predominant language of the document. 
b. Identify any sections that differ from the intended and predominant 

language. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that the language for sections identified in step 1a is 
programmatically identified. 

• Open the Tags Pane (View > Show/Hide > Navigation Panes > Tags).  
• Use the Selection tool to select sections identified in step 1a one at a 

time.  
• Find the corresponding tag (Tags Pane > Options > Find tag from 

selection). 
• View the programmatically identified language in the Tag Properties (Alt 

+ Enter > Tag tab > Language). 
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Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• The language for sections that do not match the intended and 
predominate language is not programmatically identified. 
o Fails 1194.31(a): Use Without Vision 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• The language for sections that do not match the intended and 
predominate language is not programmatically identified. 
o Fails 3.1.2: Language of Parts. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #5. 

• The language for all sections that do not match the intended and 
predominate language is programmatically identified. 
o Passes Baseline Requirement #5. 

• There are no changes in language. 
o Not applicable (Baseline Requirement #5). 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• The Accessibility Full Check has a check for “Character encoding” to 
flag fonts that, while visually correct, may not be coded to match the 
visual presentation. This is important for technologies such as screen 
readers, that convert this text into speech. When authors do not use 
Unicode fonts for languages, text may not read properly or at all. 
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6. Document Language 
Requirement 
[All Documents] 

6. The document language must be programmatically identified. 

Rationale 
[All Documents] 

 

…technical aspects A document can be programmatically marked as a specific language.  
…effects on 
accessibility 

Screen reading AT accesses the programmatic language setting to provide 
the appropriate pronunciation while speaking the document. 

…consequences If the language is not programmatically set (such as a document is written 
in Spanish but the document is programmatically set as English), then the 
speech of the screen reader could be incomprehensible to a Spanish 
speaker. 

…benefits Setting the appropriate language enables the content to be delivered as the 
author intended for screen reader users. 

…rationale Summary Summary: 
Documents can be marked as a specific language. Screen reader AT 
accesses the language setting to provide the appropriate pronunciation. 

Related Standards 
[All Documents] 

508 1194.21(d): Role, Name, State 
508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 3.1.1: Language of Page 
WCAG2 3.1.2: Language of Parts 

Tools Necessary 
[PDF] 

Document Properties, Accessibility Full Check  

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Identify the intended and predominant language of the document. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

a. Run the Accessibility Full Check and look for “Primary language” under 
Document. 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that the programmatically identified document language matches 
the language identified in step 1a. 

• Open Document Properties (File > Properties). 
• The programmatically identified document language is listed under the 

Advanced tab. 
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Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

a. If “Primary language” fails, then the Document Language was left blank 
in Document Properties and is not programmatically identified.  

b. If “Primary language” passes, then perform the manual checks to 
ensure that the selected language matches the intended and 
predominant language. 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• The intended and predominant language of the document is not 
programmatically identified. 
o Fails 1194.31(a): Use Without Vision 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• The intended and predominant language of the document is not 
programmatically identified. 
o Fails 3.1.2: Language of Parts. 
o Fails 3.1.1: Language of Page 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #5. 

• The intended and predominant language of the document is 
programmatically identified. 
o Passes Baseline Requirement #5. 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• The Accessibility Full Check has a check for “Character encoding” to 
flag fonts that, while visually correct, may not be coded to match the 
visual presentation. This is important for technologies such as screen 
readers, that convert this text into speech. When authors do not use 
Unicode fonts for languages, text may not read properly or at all. 
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7. Links and User Controls 
Requirement 
[All Documents] 

7. The distinct destination, function or purpose of links and user controls 
must be uniquely identified and described in the link/control name or 
surrounding text. 

Rationale 
[All Documents] 

 

…technical aspects Selectable links and controls can be visually represented as ambiguous 
text (such as “click here | click here | click here”), or as plain language text 
(such as “Holiday Dates”), or as ‘code’ (such as 
“http://www.dxds.tv/h2013.html”.), or as images (such as “►”). 
Combinations are also possible (such as “Play audio file ►”; “Holiday 
Dates (http://www.dxds.tv/h2013.html)”. 

…effects on 
accessibility 

To be able to understand the purpose of a link / control, screen readers 
must be able to convey an unambiguous name. 

…consequences If a link does not have an unambiguous name or description in surrounding 
text, then Screen reader AT will only be able to provide ambiguous text, 
code or images. 

…benefits Unambiguous names for links and user controls provides screen reader 
users with the ability to navigate and use content. 

…rationale Summary Summary: 
It is important to provide unambiguous names or context for link and user 
controls so that AT can correctly identify information. 

Related Standards 
[All Documents] 

508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 2.4.4: Link Purpose (In Context) 

Tools Necessary 
[PDF] 

Physical System Keyboard  

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Press the TAB key to find links and user controls. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that each link/user control in the document has a unique text 
name that describes the destination, function, and/or purpose of the 
control or that such functions are determinable within context. 

Note: 
• If an image is a link or user control, then the alt-text can contain the link 

purpose, function or destination. See Images and Other Objects, #13, 
p.42 
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Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• The destination, function, and/or purpose of a link/control is not 
conveyed in the screen text or link name. 
o Fails 1194.31(a): Use Without Vision. 
o Fails 1194.31(b): Use With Low Vision. 

• Each link/control is not uniquely identified. 
o Fails 1194.31(a): Use Without Vision. 
o Fails 1194.31(b): Use With Low Vision. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• The destination, function, and/or purpose of a link/control is not 
conveyed in the screen text or link name. 
o Fails 2.4.4: Link Purpose (In Context) 

• Each link/control is not uniquely identified. 
o Fails 2.4.4: Link Purpose (In Context) 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #7 

• The destination, function, and/or purpose of the link is contained in the 
screen text AND each link is uniquely identified. 
o Passes Baseline Requirement #7 

• There are no links or user controls. 
o Not applicable (Baseline Requirement #7) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Documents that are also meant to be published in print form must be 
allowed to use the full URL address. 
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8. Lists 
Requirement 
[All Documents] 

8. Bulleted, numbered, and multi-level lists must be programmatically 
identified. 

Rationale 
[All Documents] 

 

…technical aspects Bulleted, numbered, and multilevel lists are used to present content in 
parts. Although lists can be represented with plain text (such as preceded 
by a bullet character “●”, “□”, “◊”), they are easier to edit and manage when 
they are identified programmatically. 

…effects on 
accessibility 

When lists are programmatically identified the list parts can be navigated 
using screen reader AT. 

…consequences When lists are formatted using plain text only, they visually appear as a list 
but there is no equivalent functionality for screen reader AT. 

…benefits By using programmatically identified lists, screen reader AT functions allow 
equivalent navigation of list parts. For example, knowing how long the list is 
(is it 20 items? 200 items? or 2000 items?); understanding the relationship 
between levels (e.g. major item versus sub-level item); and being able to 
jump out of the list to the next part of the document (i.e. the next regular 
non-list paragraph).  

…rationale Summary Summary: 
Lists that are programmatically identified provide equivalent functionality 
(such as knowing the list length and understanding relationships between 
levels) for use with screen reader AT. 

Related Standards 
[All Documents] 

508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 1.3.1: Info and Relationships 

Tools Necessary 
[PDF] 

Tags Pane 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find instances of lists (bulleted, numbered, and multi-level items with a 
hierarchy - such as 2.a.iv). 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 
Note: 
• The Accessibility Full Check for “List items” checks the nesting structure 

of lists - a list tag (<L>) contains list item (<LI>) tags. However, the 
Accessibility Full Check cannot verify that visually apparent lists are 
programmatically identified; therefore, perform manual checks to 
ensure lists are correctly tagged with (<L>). 
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Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check if lists are programmatically identified. 
• Open the Tags Pane (View > Show/Hide > Navigation Panes > Tags). 
• Use the Selection tool to select lists identified in step 1a one at a time.  
• Find the corresponding tags (Tags Pane > Options > Find Tag from 

Selection). 
• Expand the list tag (select the “+” sign next to the <L> tag). 
• Check whether the selected list is programmatically identified with a list 

tag (<L>). List items are tagged with <LI> and <LI> are nested under <L>. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Lists are not programmatically identified. 
o Fails 1194.31(a): Use Without Vision. 
o Fails 1194.31(b): Use With Low Vision. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Lists are not programmatically identified. 
o Fails 1.3.1: Info and Relationships. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #8 

• Lists are programmatically identified. 
o Passes Baseline Requirement #8 

• There are no lists. 
o Not applicable (Baseline Requirement #8) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• The Accessibility Full Check for “Lbl and LBody” under Lists reports 
whether list item tags only contain label tags and list item body tags. 
While this is a common practice, it is not required for an accessible list 
structure. 

• Examples may be helpful to illustrate lists that do and do not match 
their visual structure. 
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9. Flashing (Reserved) 
Requirement 
[All Documents] 

9. Sections(s) of the screen should not flash at or above 3Hz. 
Note: 

Agencies must include an evaluation of flashing/blinking content in their test processes. 
However, as of the publication of the current version of the tests, there is no agreed-
upon testing method. 
For more information and advisory notes, see the attachment at the end of this 
document. 
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10. Data Tables (Headers) 
Requirement 
[All Documents] 

10. Header cells must be programmatically identified in data tables. 

Rationale 
[All Documents] 

 

…technical aspects To understand the data stored in a cell, or in groups of cells, it is necessary 
for the reader to be able to connect the data with the information in one or 
more headers. Typically, visual formatting is used, such as borders, bold 
fonts and shading to designate cells as being ‘headers’.  

…effects on 
accessibility 

To screen reader AT, visual formatting of headers has no inherent 
meaning. However, programmatic formatting can also be applied to cells to 
designate them as ‘headers’. 

…consequences When programmatic formatting is not applied to headers, AT is not able to 
identify the relationship between data cells and/or their associated headers.  

…benefits When programmatic formatting is properly applied, it becomes possible for 
screen reader AT users to access the same logical data-header content 
relationships that are typically provided via visual formatting. 
Notes: 
• Data tables are those tables where the information in a cell requires a 

row or column header to adequately describe the cell's contents. If a 
table is used for placement of components on the page for visual 
aesthetics, then it is a layout table. This test applies to data tables only. 

• This test applies to simple tables as well as complex data tables. 
Complex data tables are defined as those that have two or more levels 
of headers, and/or include split or merged cells.  

…rationale Summary Summary: 
To understand the data stored in a cell, or in groups of cells, it is necessary 
for the reader to be able to connect the data with the information in one or 
more headers. When programmatic formatting is properly applied, it 
becomes possible for screen reader AT users to access the same logical 
data-header content relationships that are typically provided via visual 
formatting.  

Related Standards 
[All Documents] 

508 1194.22(g): Row and Column Headers 
508 1194.22(h): Associate Data With Headers 
WCAG2 1.3.1: Info and Relationships 

Tools Necessary 
[PDF] 

Table Editor 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find data tables. Data tables are those tables where the information in 
a cell requires a row and/or column header to adequately describe the 
cell's contents. 

Note: 
• If a table is used for placement of components on the page, then it is a 

layout table and not applicable to this test. 
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Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 
Note: 
• The Accessibility Full Check has a test for Table Headers. However, 

this check only looks at the first cell of the table. Therefore, the test is 
unreliable. Perform the manual tests to verify. 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. For all data tables identified in step 1a, check if the table is 
programmatically identified. 

• Open the Order Pane (View > Show/Hide > Navigation Panes > Order). 
• View programmatically identified tables (Order Pane > Options > Check 

Show reading order panel, Show page content groups as Page content 
order, Display like elements in a single box, Show tables and figures).  

• Programmatically identified tables will be marked as “Table” on the page. 
• Data tables that are not programmatically identified fail and do not need 

additional testing. 
b. For all programmatically identified tables, check if table header cells are 

programmatically identified. 
• Open the Table Editor (Select the Table > Touch Up Reading Order > 

Table Editor). 
• Right click on the table > Table Editor Options > Select Show cell type 

(TH or TD) checkbox. 
• Programmatically identified header cells will be marked with TH and 

programmatically identified data cells will be marked with TD. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Data table header cells are not programmatically identified. 
o Fails 1194.22(g): Identify Row and Column Headers. 
o Fails 1194.22(h): Associate Data-Headers 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Data table header cells are not programmatically identified. 
o Fails 1.3.1: Info and Relationships. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #10 

• Data table header cells are programmatically identified. 
o Passes Baseline Requirement #10 

• There are no data tables in the document. 
o Not applicable (Baseline Requirement #10) 
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Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Data table captions (the name of the table) should be immediately prior 
to or following the table). See Reading Order, #2, p.17. 

• Authors may include table summaries. The Accessibility Full Check 
includes Table Summary, which is a good practice, but not part of the 
Baseline test.  

• If you receive any errors with the Table Editor, then use the tag 
structure to verify correct table tags, which are: 
<Table>, which contains all of the table rows in the table. 
<TR>, which contains all the cells in a table row. 
<TH>, which identifies a table header cell. 
<TD>, which identifies a table data cell. 
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11. Data Tables (Cell-Header Association) 
Requirement 
[All Documents] 

11. Data cells must be programmatically identified with their associated 
header cells in complex tables. 

Rationale 
[All Documents] 

 

…technical aspects To understand the data stored in a cell of a complex data table, it is 
necessary for the reader to be able to connect the data with the information 
in more than one header. Typically, multiple headers can be visually 
represented using layers of rows and columns, as well as split and merged 
header cells.  

…effects on 
accessibility 

To screen reader AT, visual formatting of headers has no inherent 
meaning. However, programmatic formatting can also be applied to data 
cells in complex tables to designate which headers the data is associated 
with. 

…consequences When programmatic formatting is not applied to headers, screen readers 
are not able to identify the relationship between data cells and/or their 
associated headers.  

…benefits When programmatic formatting is properly applied to complex data tables, 
it becomes possible for screen reader AT users to access the same logical 
data-header content relationships that are typically provided via visual 
formatting. 
Notes: 
• Data tables are those tables where the information in a cell requires a 

row or column header to adequately describe the cell's contents. If a 
table is used for placement of components on the page for visual 
aesthetics, then it is a layout table. This test applies to data tables only. 

• This test applies to complex data tables only. Complex data tables are 
defined as those that have two or more levels of headers, and/or 
include split or merged cells.  

…rationale Summary Summary: 
To understand the data stored in a cell of a complex data table, it is 
necessary for the reader to be able to connect the data with the information 
in more than one header. When programmatic formatting is properly 
applied to complex data tables, it becomes possible for screen reader AT 
users to access the same logical data-header content relationships that are 
typically provided via visual formatting.  

Related Standards 
[All Documents] 

508 1194.22(g): Row and Column Headers 
508 1194.22(h): Associate Data With Headers 
WCAG2 1.3.1: Info and Relationships 

Tools Necessary 
[PDF] 

Table Editor 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find complex data tables. Complex data tables are those tables where 
the information in a cell requires multiple headers and/or split/merged 
cells to adequately describe the cell's contents. 

Note: 
• If a table is used for placement of components on the page, then it is a 

layout table and not applicable to this test. 
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Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 
Note: 
• The Accessibility Full Check has a test for Table: “Regularity”. However, 

this check is not a reliable find for complex data tables nor is it a test for 
programmatically associated data cells. Perform the manual checks to 
verity. 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. For all data tables identified in step 1a, check if the table is 
programmatically identified. 

• Open the Order Pane (View > Show/Hide > Navigation panes > Order). 
• View programmatically identified tables (Order Pane > Options > Check 

Show reading order panel, Show page content groups as Page content 
order, Display like elements in a single box, and Show tables and 
figures).  

• Programmatically identified tables will be marked as “Table” on the page; 
data tables that are not programmatically identified will not.  

• Data tables that are not programmatically identified fail and do not need 
additional testing. 

b. For all programmatically identified tables, check if table header cells are 
programmatically associated with data cells.  

• Open the Table Editor (Select the Table > Touch Up Reading Order > 
Table Editor). 

• Open Table Cell Properties (Right click on the table cell > Table Cell 
Properties). 

• Check that header cells have an ID and the scope, row span, and column 
span matches the visual layout on the page. 

• Check that data cells contain the Associated Header Cell IDs. 
• If the above checks fail, then data cells are not programmatically 

identified with their associated header cells. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Data cells are not programmatically identified with their associated 
header cells in complex tables. 
o Fails 1194.22(g): Identify Row and Column Headers. 
o Fails 1194.22(h): Associate Data with Headers. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Data cells are not programmatically identified with their associated 
header cells in complex tables. 
o Fails 1.3.1: Info and Relationships. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #11 

• Data cells are programmatically identified with their associated header 
cells in complex tables. 
o Passes Baseline Requirement 11 

• There are no complex data tables. 
o Not applicable (Baseline Requirement #11) 
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Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• If you cannot open/use the table editor because you get the following 
error message - “Unknown table structure encountered. Please retag 
the table using the Touch Up Reading Order Tool to possibly fix the 
problem” then there is a problem with the PDF and the document must 
be remediated before testing can be completed. 

• If the Table Editor tool does not open, due to the table structure being 
corrupt, or if the Table Editor tool does not draw the overlay of the table 
correctly i.e. in accordance to the Tags Pane, a third-party tool may be 
necessary to properly test the table for conformance. 
Examples may be helpful to illustrate complex data table cell properties 
that do and do not match their visual structure.  
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12. Running Headers, Footers, and Watermarks 
Requirement 
[All Documents] 

12. Vital information contained in running headers and footers or 
watermarks must also be located at or near the start of the related 
information in the main content area.  

Rationale 
[All Documents] 

 

…technical aspects Running headers, footers and watermarks may be programmatically 
separated from the main content or body of the document. 

…effects on 
accessibility 

Running headers, footers, and watermarks may not be read by screen 
readers. 

…consequences If a user cannot see a “CONFIDENTIAL” watermark, they will not know the 
sensitivity of the information and be significantly and adversely impacted if 
they share the information with others. Or, if the running header on an 
instruction document reads “Response required within 60 days or benefits 
may be terminated,” then the reader may be significantly impacted if they 
do not know the information is there. For visual users, accessing 
information in running headers, footers and watermarks does not require 
any deliberate extra actions on their part. For screen reader AT users, they 
would have to do a great deal of extra work of examining whether there are 
running headers, running footers and watermarks for every page or section 
of every document just to find out whether vital information pertains to 
them. 

…benefits When vital information contained in the watermark and the running header 
and footer sections appears at least once at or near the start of the related 
information in the main content area, screen reader users have an 
equivalent level of access as sighted users. 
Notes: 
• In determining if the information is “vital”, consider if the reader will be 

negatively impacted if they do not read or are never aware of the 
information. 

• Automatically generated information does not need to be included in the 
main content. For example, page and section numbers are automatically 
generated by the application, and can be obtained by the reader via the 
application. 

…rationale Summary Summary: 
Running headers, footers, and Watermarks may not be read by screen 
readers. When vital information (such as “CONFIDENTIAL; DO NOT 
DISTRIBUTE”) appears at least once at or near the start of the related 
information in the main content area it will be read by screen reader AT. 

Related Standards 
[All Documents] 

508 1194.31(a) Use Without Vision 
WCAG2 1.3.2: Meaningful Sequence 

Tools Necessary 
[PDF] 

Order Pane 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Examine the document for user-generated running header and running 
footer and watermark information (such as Respond by X Date, 
Confidential, or Do Not Distribute etc.). 
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Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that vital information contained in the running headers and 
footers or watermarks is also located at or near the start of the related 
information in the programmatic Reading Order. 

• Go to the first page to which the information found in 1a applies such as 
the start of the document, the chapter, or the section. 

• Open the Tags Pane (View > Show/Hide > Navigation Panes > Tags).  
• Use the Selection tool to select running header, footer, or watermarks 

identified in step 1a one at a time.  
• Find the corresponding tag (Tags Pane > Options > Find tag from 

selection). 
• Use the arrow keys (up and down ) to check whether the running 

header, footer, or watermark is located at or near the start of the related 
information in the tags pane. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Vital information in running headers and footers or watermarks is not 
located at or near the start of the related information in the main content 
area. 
o Fails 1104.31(a): Use Without Vision 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Vital information in running headers and footers or watermarks is not 
located at or near the start of the related information in the main content 
area. 
o Fails 1.3.2: Meaningful Sequence. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #12 

• Vital information in running headers and footers or watermarks is also 
located at or near the start of the related information in the main content 
area. 
o Pass Baseline Requirement #12 

• There is no vital information in running headers and footers or 
watermarks. 
o Not applicable (Baseline Requirement #12) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Page numbers may be added by a user into running headers or running 
footers, but they are not considered ‘vital’ since they are automatically 
set by the application. Screen reader users can query the application 
for the current page number, and therefore page numbers do not need 
to be checked here. 

• Watermarks may also need to be checked for contrast. See Color 
(Contrast), #15, p.47. 

• This test is closely related to Reading Order, #2, p.17. 
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13. Images and Other Objects 
Requirement 
[All Documents] 

13. All meaningful objects must have text describing their purpose or 
function.  

Rationale 
[All Documents] 

 

…technical aspects Objects such as images, charts, and diagrams can be used to convey 
meaningful content that is necessary for understanding a document.  

…effects on 
accessibility 

Screen reading AT can access text but cannot automatically interpret the 
meaning of images and other objects. Screen readers can read text that 
has been associated with images. 

…consequences If the meaning of an image or other object is not conveyed in text, there is 
no associated information that can be accessed by screen reader AT.  

…benefits Providing text equivalents for images and other objects provides users of 
screen reader AT the intended meaning of a document’s content. 
Notes: 
• The meaning of visual information is inherently contextual. For 

example, a picture of a person running on a page about athletics is 
contextually different to the same picture of a person running on a page 
about data connection speeds. Therefore, instead of just describing a 
picture ("person running") a description is needed in context ("Come 
join the athletics team" versus "With our network speeds, you'll be 
ahead of the race"). 

• Images of text are sometimes used instead of screen text to achieve an 
artistic effect. When text is rendered as an image, the alt-text should be 
the same words verbatim. 

• Some images are decorative and convey no information. Decorative 
components do not need a description. 

…rationale Summary Summary: 
Screen reading AT can access text but cannot automatically interpret the 
meaning of images and other objects. Providing text equivalents for images 
and other objects provides users of screen reader AT the intended 
meaning of a document’s content. 

Related Standards 
[All Documents] 

508 1194.5: Equivalent Facilitation 
508 1194.22(a): Text Descriptions 
WCAG2 1.1.1: Non-text Content 
WCAG2 1.4.5: Images of Text 

Tools Necessary 
[PDF] 

Order Pane, Tags Pane, Accessibility Full Check 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Examine the document to see if there are any scanned pages (the page 
is pixilated, has low resolution, or is blurry, etc.). 

b. Find objects such as Pictures/images, Shapes, and Charts, etc. 
NOTE:  
1a.a. may contain a combination of scanned and non-scanned pages. 
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Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

a. Run the Accessibility Full Check and look for “Image only PDF” and 
“Figures alternate text.” 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Examine scanned pages for text descriptions. 
• Save the document as a text file (File>Save As Other>More 

Options>Text). 
• Check that the text in the text file and the text in the PDF file match. 
b. Examine the alternative text on images and other objects: 
c. View programmatically identified figures (Order Pane > Options > 

Check Show reading order panel, Show page content groups as 
Structure types, Display like elements in a single box, Show tables and 
figures).  

d. Programmatically identified figures will be marked as “Figure” on the 
page. 

e. View alternative text (Right click on Figure > Edit Alternative Text). 
f. If there is no alt-text, examine any caption associated with the image 

and other objects for a text description. 
g. If there is no caption associated with the image and other objects, 

examine the surrounding content (either before or after) for text that 
describes the image and other objects. 

h. Examine the descriptive text to determine whether the purpose and/or 
function of the image and other objects has been conveyed. It may be 
necessary to check the surrounding text and other content to determine 
whether the descriptive text makes sense in context. 

i. Examine the descriptive text on text rendered as an image and ensure 
the texts match verbatim. 

j. Decorative images should be set to Artifact. 
• Open the Tags Pane (View > Show/Hide > Navigation Panes > Tags).  
• Find Artifacts (Tags Pane > Options > Find > Artifacts > Search 

Document).  

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

a. If “Image only PDF” fails, then the PDF does not contain OCR text. 
b. If “Image only PDF” passes, then the PDF may contain some OCR text 

and the manual checks in 1a and 2a must be performed. 
c. If “Figures alternate text” fails, then images or objects do not contain 

alternative text or decorative images are not set to Artifact. 
b. If “Figures alternative text” passes, perform the manual checks 2a.a – 

2a.j to verify that the alt text is appropriate for each image. Be sure to 
check every image, not just the ones flagged by the Accessibility Full 
Check, because incorrect alt text or meaningful images and objects set 
to Artifact will not be flagged. 
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Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• A scanned page does not have OCR text or the OCR text does not 
match. 
o Fails 1194.22(a): Text Descriptions. 

• The purpose and/or function of a meaningful image or other object is 
not properly conveyed in descriptive text. 
o Fails 1194.22(a): Text Descriptions. 

• The descriptive text on text rendered as an image does not match 
verbatim. 
o Fails 1194.22(a): Text Descriptions. 

• A decorative image is not set to Artifact.  
o Fails 1194.22(a): Text Descriptions. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• A scanned page does not have OCR text or the OCR text does not 
match. 
o Fails 1.4.5: Image of Text. 

• The purpose and/or function of a meaningful image or other object is 
not properly conveyed in descriptive text. 
o Fails 1.1.1: Non-text Content. 

• The descriptive text on text rendered as an image does not match 
verbatim. 
o Fails 1.1.1: Non-text Content. See Testing Precondition X. 

• A decorative image is not set to Artifact.  
o Fails 1.1.1: Non-text Content. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #13 

• Meaningful images have an alt-text description AND its meaning, 
and/or purpose is described. 
o Passes Baseline Requirement #13 

• There are no images. 
o Not applicable (Baseline Requirement #13) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Background images and watermarks should be tested for color 
contrast. See Color (Contrast), #15, p.47. 

• Providing alternate/descriptive text is a subjective task, requiring 
consideration of factors such as subject matter knowledge. 

• Images of scanned text should be converted to accessible text. See 
Testing preconditions. 

• Alt-text should be 250 characters or less. For complex images, it is a 
best practice to contain the description in the body of the document or 
an appendix. 

• All Baseline tests are applicable to scanned documents unless 
agencies are using an equivalent facilition solution. See Precondition 
#4 Equivalent Facilitation. 
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14. Color and Other Sensory Characteristics 
Requirement 
[All Documents] 

14. Information conveyed through sensory characteristics (such as color, 
size, shape, and location) must also be provided in text.  

Rationale 
[All Documents] 

 

…technical aspects A sensory characteristic can be used to convey information. For example, a 
dot in a table cell is green for 'project on schedule', orange for 'delayed', 
and red for 'past due'. In this case color is the sensory characteristic that 
changes. 

…effects on 
accessibility 

For any given sensory characteristic, some users will not be able to rely on 
that characteristic. For example, non-visual users cannot rely on visual 
size, shape and location. If an instruction for interactive content says “press 
the bigger dot to the right move forward, and the smaller dot to the left 
return to the beginning”, non-visual users will not be able to discern the 
visual differences between the controls. 

…consequences When sensory characteristics are the only means used to convey 
information, people who are blind, color blind or have low vision do not 
have equal access to the information.  

…benefits When information that is being conveyed by sensory characteristics is also 
available in a textual format (such as in a control’s text name), it can be 
accessed using screen reader AT. 
Note: 
This requirement does not mean that sensory characteristics cannot be 
used; it means they cannot be the only means of conveying the 
information. 

…rationale Summary Summary: 
When information is being conveyed by sensory characteristics such as 
color, size, shape and location it must also be available in a textual format 
so that it can be accessed by users who are blind, low-vision or colorblind. 

Related Standards 
[All Documents] 

508 1194.22(c): Color Dependence 
508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 1.3.3: Sensory Characteristics 
WCAG2 1.4.1: Use of Color 

Tools Necessary 
[PDF] 

None 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find where sensory characteristics are used to convey meaning, 
indicate an action, or prompt a response. Include: 

• Text color 
• Images, charts and diagrams 
• Links and user controls 
• Data table cell contents (such as status indicators) 
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Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Where sensory characteristics are used to convey meaning, determine 
if meaning is also present via screen text. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Information conveyed through color is not conveyed textually. 
o Fails 1194.22(c): No Color Dependence to Convey Information 

• Information conveyed through a sensory characteristic (other than 
color) is not conveyed textually. 
o Fails 1194.31(a): Use Without Vision 
o Fails 1194.31(b): Use With Low Vision 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Information conveyed through a sensory characteristic (including color) 
is not conveyed textually. 
o Fails 1.3.3: Sensory Characteristics 
o Fails 1.4.1: Use of Color 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #14 

• All information conveyed through sensory characteristics (including 
color) is also conveyed textually. 
o Passes Baseline Requirement #14 

• There is no information conveyed through sensory characteristics 
(including color). 
o Not applicable (Baseline Requirement #14) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• This test is closely related to, and may be combined with, the test for 
Color (Contrast), #15, p.47. 

• If you cannot open/use the table editor, then there is a problem with the 
PDF and the document must be remediated before testing can be 
completed. 
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15. Color (Contrast) 
Requirement 
[All Documents] 

15. Text and Images of text must have contrasting colors/shades at a ratio 
of 4.5:1 for discerning between background and foreground and at a ratio 
of 3:1 for large text (14pt bold or 18pt regular). Exclude incidental text, text 
overlaid on images, and logotypes. 

Rationale 
[All Documents] 

 

…technical aspects Color/shade choices that do not contrast well with each other may be 
deliberate (i.e. artistic preference), or they may be the result of 
programmatic features (e.g. a button's text is black on white, but the text 
turns yellow in a certain mode, and the background remains white). 

…effects on 
accessibility 

Visual contrast sensitivity reduces as people age. Screen brightness, 
ambient light, color blindness and some types of low vision are also 
contributing factors to perceived contrast levels. 

…consequences Having a low level of contrast between foreground text and the background 
will mean that some people will be unable to see the content as intended. 

…benefits In general, the higher the level of contrast used, the more people will be 
able to see and use the content. 
Note: 
Large text is defined here as 14pt bold font or larger, or 18pt regular font or 
larger. 

…rationale Summary Summary: 
Having a higher level of contrast between foreground text and the 
background results in more people will being able to see and use the 
content. 

Related Standards 
[All Documents] 

508 1194.31(b): Use With Low Vision 
WCAG2 1.4.3: Contrast (Minimum) 

Tools Necessary 
[PDF] 

See Attachment D – Color contrast Analyzers 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Examine text or images of text for areas that may have low background 
to foreground contrast. Include: 

• Text in foreground versus background. 
• Links (especially visited links that may be grayed out). 
• Text in images. 
• Text in foreground versus background images and watermarks (the 

watermark should not interfere with the foreground text, as can happen 
when there is too little contrast). 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 
Note: 
• The Accessibility Full Check has a check for Color Contrast, which 

always needs a manual check. Perform the manual checks 1a.a and 
2a.a to verify. 
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Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Use one of the Color contrast analyzing tools identified in Attachment E 
to Perform a Color contrast test on items identified in step 1a to ensure 
that there is sufficiently high contrast for text: 

• 4.5:1 for regular text 
• 3:1 for large text (14pt bold or 18pt regular). 
NOTE: 
• Exclude incidental text, text overlaid on images, and logotypes. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Contrast ratio for text and images of text is less than 4.5:1 (3:1 for large 
text), except for incidental text, text overlaid on images, and logotypes. 
o Fails 1194.31(b): Use With Low Vision. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Contrast ratio for text and images of text is less than 4.5:1 (3:1 for large 
text), except for incidental text, text overlaid on images, and logotypes. 
o Fails 1.4.3: Contrast (Minimum). 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #15 

• Contrast ratio for text and images of text is 4.5:1 (3:1 for large text) or 
greater, except for incidental text, text overlaid on images, and 
logotypes. 
o Passes Baseline Requirement #15 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Proper formatting of text colors may make text more accessible when 
the page is viewed in high contrast mode (an accessibility feature in the 
MS Windows Operating System, AT, Adobe Reader, Adobe Acrobat 
Standard, and Adobe Acrobat Professional). 
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16. Audio (Transcripts) 
Requirement 
[All Documents] 

16. Meaningful audio-only content must be accompanied by a text 
transcript.  

Rationale 
[All Documents] 

 

…technical aspects Embedded audio-only content (such as speeches and recorded meetings) 
can contain meaningful information necessary to understand a document. . 

…effects on 
accessibility 

Some users will not be able to rely on audio. 

…consequences If there is no text equivalent to the audio, the meaning contained in the 
content will not be available.  

…benefits Providing a text only version of what is being said, and/or a description of 
the relevant sounds gives equivalent access to the content for people who 
are unable to rely on audio. 
Notes: 
• Audio-only content may be delivered as an embedded file, as streamed 

file, or other means. 
• Other short sounds such as confirmation beeps and error notifications 

are not included in this requirement. 
• ‘Decorative’ audio would include background music that conveys no 

content. 
…rationale Summary Summary: 

Providing a text only version of what is being said and/or a description of 
the relevant sounds gives equivalent access to the content for people who 
are deaf or hard of hearing. 

Related Standards 
[All Documents] 

508 1194.22(a): Text Descriptions 
508 1194.31(c): Use Without Hearing 
WCAG2 1.1: Non-text Content 
WCAG2 1.2.1: Audio-only and Video-only (Prerecorded) 

Tools Necessary 
[PDF] 

None  

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find interface components that play audio-only content when activated. 
Look for links, controls (buttons), audio file icons etc. 

b. Find other audio content that plays automatically (upon opening a 
document). 

Note: 
• An audio-only file may be stored in a synchronized media format. For 

example, a speech is stored in a file where the video is simply a static 
graphic of the speaker's name and location. If the video component is 
static, and the information displayed in the video is also available as 
screen text, then treat the file as audio-only. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 
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Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that the transcript is accessible screen text (i.e. an image of a 
transcript without alt-text would fail this test). 

• Open the transcript and play the audio-only content, Compare that the 
information in the transcript is an accurate and complete representation 
of the audio-only content. Note the inclusion or absence of relevant 
associated sounds in addition to any dialogue/narration, such as doors 
banging or sirens wailing. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 fail 
conditions 
[PDF] 

• Audio-only content is not accompanied by a transcript. 
o Fails 1194.22(a): Text Descriptions. 
o Fails 1194.31(c): Use Without Hearing 

• Audio-only content is accompanied by a transcript that is inaccurate or 
incomplete. 
o Fails 1194.22(a): Text Descriptions. 
o Fails 1194.31(c): Use Without Hearing 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Audio-only content is not accompanied by a transcript. 
o Fails: 1.1.1: Non-Text Content. 
o Fails 1.2.1: Audio-only and Video-only (Prerecorded). 

• Audio-only content is accompanied by a transcript that is inaccurate or 
incomplete. 
o Fails: 1.1.1: Non-Text Content 
o Fails 1.2.1 Audio-only and Video-only (Prerecorded) 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #16 

• Audio-only content has a transcript supplied AND the transcript is an 
accurate and complete representation of the audio-only content. 
o Passes Baseline Requirement #16 

• There are no audio-only files. 
o Not applicable (Baseline Requirement #16) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• If audio is synchronized with video, slides, animations, or other time-
based visual media, then use the synchronization test instead. 

• The proximity of the audio content to any control to reveal the transcript 
is covered by the Reading Order test (such as whether there is a logical 
order for content). 

• Transcripts may be file attachments or part of a PDF portfolio. 
• Testing of media players is usually a software test of the plug-in. 
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17. Video (Descriptions) 
Requirement 
[All Documents] 

17. Meaningful video-only content must be accompanied by a description.  

Rationale 
[All Documents] 

 

…technical aspects Embedded video-only content (such as animations and slideshows.) can 
contain meaningful information necessary to understand a document. . 

…effects on 
accessibility 

Some users will not be able to rely on video. 

…consequences If there is no text equivalent to the video, the meaning contained in the 
content will not be available.  

…benefits Providing a text only version of what is being shown, and/or a description of 
the relevant video gives equivalent access to the content for people who 
are unable to rely on video. 
Notes: 
• Short animation effects such as button activation highlights and file 

shrink/disappear on closure are not included in this requirement. 
• ‘Decorative’ video includes background images that convey no content. 

…rationale Summary Summary: 
Providing a text only version of what is being shown and/or a description of 
the relevant video gives equivalent access to the content for people who 
are blind or low vision. 

Related Standards 
[All Documents] 

508 1194.21(h): Animations 
508 1194.22(a): Text Descriptions 
508 1194.24(d): Video Descriptions 
508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low vision 
WCAG2 1.1.1: Non-text Content 
WCAG2 1.2.1: Audio-only and Video-only (Prerecorded) 

Tools Necessary 
[PDF] 

None 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find interface components that play video-only content when activated. 
Look for links, controls (buttons), video file icons etc. 

b. Find other video content that plays automatically (such as upon 
opening a document). 

Note: 
• A video-only file may be stored in a synchronized media format. For 

example, an animation is stored in a file where the audio is absent or 
can be considered incidental (such as background music that does not 
influence the comprehension of the animation). If the audio component 
is absent or incidental, then treat the file as video-only. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 
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Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that the description is available as accessible screen text (such 
as an image of a description without alt-text would fail this test) or as an 
audio file. 
• Open the description and play the video-only content. Check that 

the information in the description is an accurate and complete 
representation of the video-only content. 

Note: 
• When accompanying a video-only file with an audio description file, the 

files do not have to be synchronized. 
Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A  

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• A video-only file does not have a description. 
o Fails 1194.21(h): Animation. 

• A video-only file has text descriptions that are inaccurate or incomplete. 
o Fails 1194.21(h): Animation. 
o Fails 1194.22(a): Equivalent Text Descriptions. 

• A video-only file has audio descriptions that are inaccurate or 
incomplete. 
o Fails 1194.21(h): Animation. 
o Fails 1194.24(d): Video descriptions. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Video-only content does not have a description. 
o Fails: 1.1.1: Non-Text Content. 
o Fails 1.2.1: Audio-only and Video-only (Prerecorded). 

• Video-only content has text descriptions that are inaccurate or 
incomplete OR audio descriptions that are inaccurate or incomplete. 
o Fails: 1.1.1: Non-text Content. 
o Fails 1.2.1: Audio-only and Video-only (Prerecorded). 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #17 

• Video-only content has descriptions supplied AND the descriptions are 
an accurate and complete representation of the video-only content. 
o Passes Baseline Requirement #17 

• There is no video-only (/animation) content. 
o Not applicable (Baseline Requirement #17) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• If video is synchronized with audio, meaningful sounds, narration, or 
other time based visual media, then use the synchronization test 
instead. 

• The proximity of the video content to any control to reveal the 
description is covered by the Reading Order Test (such as whether 
there is a logical order for content). 

• Text or audio descriptions may be file attachments or part of a PDF 
portfolio. 

• Testing of media players is usually a software test of the plug-in. 
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18. Synchronized Media (Captions) 
Requirement 
[All Documents] 

18. Synchronized media must have captions that are time-synchronized 
with the dialog and relevant sounds. 

Rationale 
[All Documents] 

 

…technical aspects Embedded media content includes time-synchronized video and audio 
(such as movie clips, spoken presentations, and narrated slide-shows) can 
contain meaningful information necessary to understand a document. . 

…effects on 
accessibility 

Some users will not be able to rely on audio. Therefore, there needs to be a 
synchronized text only version of what is being said, and/or a description of 
the relevant sounds. 

…consequences If there are no captions for the audio, the meaning contained in the content 
will not be available.  

…benefits Providing time-synchronized captions of what is being said, and/or a 
description of the relevant sounds gives equivalent access to the 
multimedia content for people who are unable to rely on audio. 
Notes: 
• Captions need to be available, but are not required to be turned on by 

default. For example, users who need captions can switch them on with 
a control. If there is no means of switching modes, then the captions 
must be always on (i.e. the content is ‘open captioned’). 

• The captions must allow understanding of the relevant information. For 
example, captions might include loud bangs, floorboards creaking, or 
alarms sounding. 

• Synchronization is required for the Alternative presentation modes. 
Because captions must be synchronized, a text transcript will not meet 
this requirement. Synchronized media content cannot be played and 
then followed by a Summary of the sounds. Instead, the auditory events 
must be conveyed as they are happening. 

…rationale Summary Summary: 
Providing time-synchronized captions of what is being said, and/or a 
description of the relevant sounds gives equivalent access to the 
multimedia content for people who are deaf or hard of hearing. 

Related Standards 
[All Documents] 

508 1194.22(b): Synchronized Alternatives 
508 1194.24(c): Captions 
508 1194.31(c): Use Without Hearing 
WCAG2 1.2.2: Captions (Prerecorded) 
WCAG2 1.2.4: Captions (Live) 

Tools Necessary 
[PDF] 

None  
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Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find interface components that play synchronized media when 
activated. This includes embedded media files and links to streaming 
live events. 

b. Find other synchronized media content that plays automatically (e.g. 
upon opening a document). 

Note: 
• A synchronized media file may be used to store non-synchronized 

media format. For example, a speech is stored in a synchronized media 
file where the video is simply a static image of the speaker's face with a 
caption. If the video component is static, and the information displayed 
in the video is also available as screen text, then treat the file as audio-
only rather than synchronized media. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Enable the captioning for the synchronized media. 
b. Play the synchronized media content. Check that the information in the 

captions is an accurate, synchronized and complete representation of 
the dialogue and other relevant sounds in the synchronized media.. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Synchronized media does not have captions. 
o Fails 1194.24(c): Captions. 

• Synchronized media has captions that are inaccurate or incomplete. 
o Fails 1194.24(c): Captions. 

• Synchronized media has captions that are not synchronized with dialog 
and relevant sounds. 
o Fails 1194.22(b): Synchronized Alternatives. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Synchronized media does not have captions. 
o Fails 1.2.2: Captions (Prerecorded). 

• Synchronized media has captions that are inaccurate or incomplete. 
o Fails 1.2.2: Captions (Prerecorded). 

• Synchronized media has captions that are not synchronized with dialog 
and relevant sounds. 
o Fails 1.2.2: Captions (Prerecorded).  
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Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #18 

• Synchronized media has captions AND the captions are an accurate, 
synchronized and complete representation of the audio contained in the 
synchronized media. 
o Passes Baseline Requirement #18 

• There is no synchronized media. 
o Not applicable (Baseline Requirement #18) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Testing synchronized media is different from testing audio-only content 
(test #16). 

• Testing synchronized captions AND synchronized descriptions at the 
same time may be more time effective, so long as both are given equal 
weight. 

• It is preferable to have the media on the main page for all users 
captioned and audio described, as current technology permits this. 
However, it is acceptable to have separate files for captioned and/or 
audio described versions. 

• Testing of synchronized media players is usually a software test of the 
plug-in. 
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19. Synchronized Media (Descriptions) 
Requirement 
[All Documents] 

19. Synchronized media must have audio descriptions that are time-
synchronized with the video. 

Rationale 
[All Documents] 

 

…technical aspects Embedded media content includes time-synchronized video and audio 
(such as movie clips, spoken presentations, and narrated slide-shows) can 
contain meaningful information necessary to understand a document. . 

…effects on 
accessibility 

Some users will not be able to rely on video. Therefore, there needs to be a 
synchronized auditory version of what is being shown, and/or a description 
of the relevant visual events. 

…consequences If there are no audio descriptions for the video, the meaning contained in 
the content will not be available.  

…benefits Providing time-synchronized audio descriptions of what is being shown, 
and/or a description of the relevant visual events gives equivalent access to 
the multimedia content for people who are unable to rely on video. 
Notes: 
• Descriptions need to be available, but are not required to be turned on 

by default. For example, users who need descriptions can switch them 
on with a control. If there is no means of switching modes, then the 
descriptions must be always on. 

• The descriptions must allow understanding of the relevant information. 
For example, descriptions might include the looks on people’s faces, 
people handing items to each other, or who has entered the room. 

• Synchronization is required for the Alternative presentation modes. 
Because descriptions must be synchronized, a separate text 
description will not meet this requirement. Synchronized media content 
cannot be played and then followed by a Summary of the visual events. 
Instead, the visual events must be described as they are happening. 

…rationale Summary Summary: 
Providing time-synchronized audio descriptions of what is being said, 
and/or a description of the relevant visual events gives equivalent access to 
the multimedia content for people who are blind or low vision. 

Related Standards 
[All Documents] 

508 1194.22(b): Synchronized Alternatives 
508 1194.24(d): Video Descriptions 
508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 1.2.3: Audio Description or Media Alternative (Prerecorded) 
WCAG2 1.2.5: Audio Description (Prerecorded) 

Tools Necessary 
[PDF] 

None  
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Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find interface components that play synchronized media when 
activated. This includes embedded media files, and links to streaming 
live events. 

b. Find other synchronized media content that plays automatically such as 
upon opening a document. 

Notes: 
• A synchronized media file may be used to store non-synchronized 

media format. For example, an animation is stored in a synchronized 
media file where the audio is absent or can be considered incidental 
(e.g. background music that does not influence the comprehension of 
the animation). If the audio component is absent or incidental, then 
treat the file as video-only. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Enable the audio descriptions for the synchronized media. 
b. Play the synchronized media content. 
c. Check that the audio description is an accurate, synchronized and 

complete representation of the relevant visual events in the 
synchronized media.  

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Synchronized media is not audio described. 
o Fails 1194.24(d): Descriptions. 

• Synchronized media is audio described, but the descriptions are 
inaccurate or incomplete. 
o Fails 1194.24(d): Descriptions. 

• Synchronized media is audio described, but the descriptions are not 
synchronized with video. 
o Fails 1194.22(b): Synchronized Alternatives. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Synchronized media is not audio described. 
o Fails 1.2.3: Audio Description or Media Alternative (Prerecorded). 
o Fails 1.2.5: Audio Description (Prerecorded). 

• Synchronized media is audio described, but the descriptions are 
inaccurate or incomplete. 
o Fails 1.2.3: Audio Description or Media Alternative (Prerecorded). 
o Fails 1.2.5: Audio Description (Prerecorded). 

• Synchronized media is audio described, but the descriptions are not 
synchronized with video. 
o Fails 1.2.3: Audio Description or Media Alternative (Prerecorded). 
o Fails 1.2.5: Audio Description (Prerecorded). 
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Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #19 

• Synchronized media is audio described AND the descriptions are an 
accurate, synchronized and complete representation of the video 
contained in the synchronized media. 
o Passes Baseline Requirement #19 

• There is no synchronized media. 
o Not applicable (Baseline Requirement #19)  

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• Testing synchronized media is different from testing video-only content 
(test #17). 

• Testing synchronized captions AND synchronized descriptions at the 
same time may be more time effective, so long as both are given equal 
weight. 

• It is preferable to have the media on the main page for all users 
captioned and audio described, as current technology permits this. It is 
acceptable to have separate files for captioned and/or audio described 
versions. 

• Testing of synchronized media players is usually a software test of the 
plug-in. 
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20. Forms 
Requirement 
[All Documents] 

20. Labels, instructions, directions and cues necessary to complete a form 
must be programmatically or textually associated with their respective input 
control.  

Rationale 
[All Documents] 

 

…technical aspects In order to correctly and accurately complete a form, it is necessary to 
follow instructions, directions and cues, as well as enter information in the 
correct fields. 

…effects on 
accessibility 

If cues are only visually associated with controls (e.g. by visual proximity), it 
may not be possible for users without vision, or with low vision, to find the 
related instructions for the current form component. If input controls are not 
textually identified, then users without vision, or with low vision, may find it 
difficult or impossible to be certain they are filling out the form correctly 
(e.g. is this field for my name, or my spouses name?). 

…consequences When forms are created that rely on visual cues only (i.e. there are no 
programmatic links between instructions and named form components), 
users who cannot rely on vision may find it difficult or impossible to fill out 
the form. 

…benefits Non-visual use of a form is facilitated when there is a programmatic 
association between all relevant instructions, directions and cues and their 
respective components/controls. 
Notes: 
• A given form component may be the subject of instructions that are not 

positioned next to the component (e.g. at the top of a form, the 
instruction is "If you are the home owner, complete parts a, b, and f"). In 
such cases, form designers will use visual layout and flow to direct the 
user. In such cases the user must be able to access all relevant 
instructions when using the given form component(s). 

• Read-only (i.e. pre-filled) form fields are considered interactive, in that 
they need to be in the tab order and must be associated with their 
visual label through a tool tip. 

• It is implicit in this requirement that the ability to read instructions and 
cues and fill in form components must be achievable in one mode of 
operation (i.e. there cannot be one mode to read the form’s instructions 
and another mode to fill in the form elements). 

…rationale Summary Summary: 
In order to correctly and accurately complete a form, it is necessary to 
follow instructions, directions and cues, as well as enter information in the 
correct fields. Non-visual use of a form is facilitated when there is a 
programmatic association between all relevant instructions, directions and 
cues and their respective components/controls. 

Related Standards 
[All Documents] 

508 1194.21(a): Keyboard Accessibility 
508 1194.21(l): Forms 
508 1194.22(n): Labels for Forms 
508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 1.3.1: Info and Relationships  
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Tools Necessary 
[PDF] 

Physical System Keyboard, Accessibility Full Check 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Find all form input components. Examples include buttons, text fields, 
radio buttons, checkboxes, multi-select lists (combo boxes). 

b. Find all instructions and cues (textual and graphical) that are related to 
form components/controls, including groupings, order of completion, 
special conditions or qualifiers, etc. 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

a. Run the Accessibility Full Check and look for Forms “Field 
descriptions.” 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that Labels, instructions, directions and cues necessary to 
complete a form field are programmatically or textually associated with 
the input control.  

• TAB to or hover over components found in step 1a a to reveal the tooltips 
(i.e. programmatically associated labels, instructions, directions and 
cues). 

• Check that the tooltips match the instructions and cues found in step 1a 
b. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

a. If Forms “Field descriptions” fails, then tooltips were left blank and 
labels, instructions, directions and cues necessary to complete a form 
are not programmatically or textually associated with their respective 
input control. 

b. If Forms “Fields descriptions” passes, then perform the manual checks 
to verify that the tooltip is appropriate for each field. Be sure to check 
every field, not just the ones flagged by the automated checker, 
because incorrect tooltips will not be flagged. 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Labels, instructions, directions and cues necessary to complete a form 
are not programmatically or textually associated with their respective 
input control. 
o Fails 1194.31(a): Use Without Vision. 
o Fails 1194.31(b): Use Without Vision. 
o Fails 1194.22(n): Labels for Forms. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Labels, instructions, directions and cues necessary to complete a form 
are not programmatically or textually associated with their respective 
input control.  
o Fails 1.3.1: Info and Relationships. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #20 

• Labels, instructions, directions and cues necessary to complete a form 
are programmatically or textually associated with their respective input 
control.  
o Passes Baseline Requirement #20 

• There are no forms. 
o Not applicable (Baseline Requirement #20) 
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Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• When creating accessible forms you must also consider tab order see 
Reading Order #2. p.19. 

• This PDF Baseline does not cover Adobe LiveCycle. See 
precondition#1.  
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21. Focus (Revealing Hidden Content) 
Requirement 
[All Documents] 

21. Components that reveal hidden content (text boxes, thumbnail images, 
call-outs, comments, light boxes, pop-ups etc.) must either (i) shift focus to 
the content they reveal, or (ii) the component must describe that a change 
to the content will occur if selected. 

Rationale 
[All Documents] 

 

…technical aspects Some components can be intentionally hidden to reduce visual clutter, 
requiring a user action to reveal the content. 

…effects on 
accessibility 

It is normally easy for visual users to see that content has been revealed. 
However, for non-visual users, the fact that content has been revealed may 
not be apparent, unless the focus moves to the revealed content. If focus 
does not move to the revealed content, then a description could be used to 
inform the user of what happens when that control is selected. 

…consequences If there is neither a shift in focus nor an a description of changes to content, 
then users of screen reader AT may be unaware that the visually revealed 
content exists. This content may be essential for understanding and using 
the document. 

…benefits Providing focus changes to the revealed content or describing the changes 
ensures that screen reader AT users will have access to the information as 
intended by the author. 

…rationale Summary Summary: 
Some components can be intentionally hidden to reduce visual clutter, 
requiring a user action to reveal the content. Providing focus changes to 
the revealed content or describing the changes ensures that screen reader 
AT users will have access to the information as intended by the author. 

Related Standards 
[All Documents] 

508 1194.21(a): Keyboard Accessibility  
508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2 2.4.3: Focus Order 
WCAG2 3.2.2: On Input 

Tools Necessary 
[PDF] 

N/A 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

N/A (See Advisory tips) 

Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 
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Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

N/A (See Advisory tips). 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

N/A (See Advisory Tips) 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

N/A (See Advisory Tips) 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Document contains components that reveal hidden content. 
o Not Applicable Baseline Requirement #21. 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• The Accessibility Full Check will flag the presence of “Scripts “in a 
document. Adding programmed formatting to a document effectively 
turns it into a software application. Software applications should be 
tested using appropriate software testing methods. Therefore, this test 
process does not apply. 

• This PDF Baseline does not cover scripts. See precondition#2. 
• ‘Balloon comments’ are not included in this test. 
• Links that open other external documents are not included in this test. 
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22. Alternative Accessible Version 
Requirement 
[All Documents] 

22. An alternative accessible version must contain equivalent and up-to-
date content when the primary document cannot be made accessible. 

Rationale 
[All Documents] 

 

…technical aspects Some information is inherently visual in nature (e.g. geographic maps, 
organizational charts). 

…effects on 
accessibility 

There may be instances where an alternate version of a primary document 
is provided, because an agency has determined that the primary document 
cannot be made accessible (e.g. a complex organizational chart may have 
to be written in prose, and this prose cannot fit within the specified page 
limits of the primary document). 

…consequences When an alternative accessible version is supplied, if the content in the 
alternative version is not kept up-to-date, or is not equivalent, then users 
who rely on the alternative version will be at a disadvantage. For example, 
a policy specifies that when severe weather is anticipated a map is 
supplied to employees, and an alternate text-only version is supplied at the 
same time. Therefore, those in charge of releasing the severe weather 
bulletins must be trained to always create an equivalent, up-to-date text-
only version. 

…benefits Providing an accessible version is only useful when the information is 
equivalent and up-to-date. 
Note: 
The information should be 'equivalent' but by definition this is not going to 
be 'exactly the same'. The main points, themes, concepts etc. that the 
authors are trying to convey in the primary content should also be present 
in the alternate format. For example, if a complex chart in the primary 
document shows a year with a small increase in Q2 earnings and a large 
decrease in Q3 and the text discusses why these trends occur, the 
alternative accessible version should convey the high and low data points 
of interest and the trends. An alternative accessible version that just gave 
all the data points with no mention of the trends would not be considered 
equivalent. 

…rationale Summary Summary: 
There may be instances where an alternate accessible version of a primary 
document is provided, because an agency has determined that the primary 
document cannot be made accessible. Providing an alternative accessible 
version is only useful when the information is equivalent and up-to-date. 

Related Standards 
[All Documents] 

508 1194.22(k): Alternative Versions 
WCAG2: Conformance requirement #1: Conforming Alternate Version 

Tools Necessary 
[PDF] 

None 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Determine whether there are any alternate documents by examining 
the content (pay particular attention to content containing maps, 
directions, complex charts etc.). 

b. Examine attachments or PDF portfolio for alternate documents. 
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Test Instruction 1b: 
Accessibility Full 
Check Find of 
Applicable 
Components 
[PDF] 

N/A 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Compare the content of the primary document and the alternate format, 
noting any information differences and/or out-of date material. 

Test Instruction 2b: 
Accessibility Full 
Check for 
Inspecting/Using 
Components 
[PDF] 

N/A 

Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• An alternate version is provided, but the information is not equivalent to 
and up to date with the primary document. 
o Fails 1194.22(k): Text Only or Alternative versions. 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• An alternate version is provided, but the information is not equivalent to 
and up to date with the primary document. 
o Fails Conformance Requirement #1: Conforming Alternate Version. 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #22 

• An alternate version contains equivalent, up-to-date information 
compared with the primary document. 
o Passes Baseline Requirement #22 

• The primary document(s) are accessible and no alternate versions are 
used. 
o Not applicable (Baseline Requirement #22) 

Advisory: Tips to 
enhance or streamline 
test processes 
[PDF] 

• This is a test of equivalency of the information on an alternate format 
and not a test of whether or not there should be an alternative version. 

• The alternate format version must pass all relevant tests for 
accessibility. 

• The decision of whether to actually provide an alternate format or not 
will rest with individual agencies based on their policies. 

• The definition of ‘up-to-date’ rests with individual agency (such as 
immediately with any changes, within an hour, within a day etc.). 
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23. Security and Protection 
Requirement 
[All Documents] 

0. Security and protection settings must allow content copying for AT. 

Rationale 
[All Documents] 

 

…technical aspects Security and protection settings can prevent users from editing content and 
enable features (e.g. filling in and completing forms). 

…effects on 
accessibility 

Some security and protection settings may also prevent AT from accessing 
content. 

…consequences AT users may not have access to information. 
…benefits Documents, protected in a way that does not interfere with AT, will ensure 

all users have access to information. 
…rationale Summary Summary: 

Security and protection settings can prevent users from editing content; 
therefore, ensure settings allow AT access, so that users have access 
information. 

Related Standards 
[All Documents] 

508 1194.21(b): Built-in Accessibility Features 
508 1194.31(a): Use Without Vision 
508 1194.31(b): Use With Low Vision 
WCAG2: 1.4.4 Resize text 
WCAG 2: Conformance requirement #5: Non-interference 

Tools Necessary 
[PDF] 

Document Properties, Accessibility Full Check 

Test Instruction 1a: 
Manual Find of 
Applicable 
Components 
[PDF] 

a. Examine the Security settings in Document Properties (File > 
Properties > Security). 

Test Instruction 1b: 
Automated Checker 
Find of Applicable 
Components 
[PDF] 

a. Run the Accessibility Full Check and look for Document “Accessibility 
permissions flag.” 

Test Instruction 2a: 
Manual check for 
Inspecting/Using 
Components 
[PDF] 

a. Check that “Content Copying for Accessibility” (for AT) is “Allowed.” 

Test Instruction 2b: 
Automated Checker for 
Inspecting/Using 
Components 
[PDF] 

a. If “Accessibility permissions flag” fails, then content copying for 
assistive technology is not allowed. 
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Test Instruction 3a: 
Section 508 Failure 
Conditions 
[PDF] 

• Content copying for AT is not allowed. 
o Fails: 1194.21(b) Built-in Accessibility Features 
o Fails: 1194.31(a): Use Without Vision 
o 508 1194.31(b): Use With Low Vision 

Test Instruction 3b: 
WCAG2 Failure 
Conditions 
[PDF] 

• Content copying for AT is not allowed. 
o Fails 4.1: Compatible 

Test Instruction 3c: 
Baseline Requirement 
Test Results 
[PDF] 

• Any failure in 3a. 
o Fails Baseline Requirement #0 

• Content copying for AT is allowed. 
o Passes Baseline Requirement #0 

Advisory: Tips for 
streamlined test 
processes 
[PDF] 

• In a streamlined test process, this test should be listed first. 
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Attachment A - Cross-Reference Tables 
Note: 
The names for Section 508 tests are provided as short-hand for reference in the tables that follow 
and are not the official names. Refer to the standards for the official text. 



Baseline Tests for Accessible Electronic Documents—PDF (Portable Document Format) 

Page 69 

Baseline Tests (cross-reference table) 
No. Baseline test Section 508 coverage WCAG 2 (reference only) 
23. Security and Protection 21 SW (b): Built-in Accessibility 

Features 
31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

1.4.4: Resize text 
Conformance requirement #5: Non-
interference 

1. Inline Elements 21 SW (a): Keyboard Accessibility 
31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 
31 FPC (f): Use With Physical 
Limitations 

1.3.1: Info and Relationships 
2.1.1: Keyboard 

2. Reading Order 31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 
31 FPC (f): Use With Physical 
Limitations 

1.3.2: Meaningful Sequence 
2.4.3: Focus Order 

3. Document Title 
(Filename) 

31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

2.4.2: Page Titled 

4. Headings 31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 
31 FPC (f): Use With Physical 
Limitations 

1.3.1: Info and Relationships 
 

5. Section Language 31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

3.1.2: Language of Parts 

6. Document Language 21 SW (d): Role, Name, State 
31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

3.1.1: Language of Page 
3.1.2: Language of Parts 

7. Links and User Controls 31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

2.4.4: Link Purpose (In Context) 

8. Lists 31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

1.3.1: Info and Relationships 

9.  Flashing (Reserved) 21 SW (k): Blinking Objects 
22 Web (j): No flickering Interface 
components. 

2.3.1 Three flashes or below 
threshold 

10. Data Tables (Headers) 22 Web (g): Row and Column 
Headers 
22 Web (h): Associate Data With 
Headers 

1.3.1: Info and Relationships 

11. Data Tables (Cell-
Header Association) 

22 Web (g): Row and Column 
Headers 
22 Web (h): Associate Data With 
Headers 

1.3.1: Info and Relationships 

12. Running Headers, 
Footers, and 
Watermarks 

31 FPC (a): Use Without Vision 1.3.2: Meaningful Sequence 
 

13. Images and Other 
Objects 

22 Web (a): Text Descriptions 1.1.1: Non-text Content 
1.4.1: Use of Color 
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No. Baseline test Section 508 coverage WCAG 2 (reference only) 
14. Color and Other Sensory 

Characteristics 
22 Web (c): Color Dependence 
31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low vision 

1.3.3: Sensory Characteristics 
1.4.1: Use of Color 

15. Color (Contrast) 31 FPC (b): Use With Low Vision 1.4.3: Contrast (Minimum) 
16. Audio (Transcripts) 22 Web (a): Text Descriptions 

31 FPC (c): Use Without Hearing 
1.1.1: Non-text Content 
1.2.1: Audio-only and Video-only 
(Prerecorded) 

17. Video (Descriptions) 21 SW (h): Animations 
22 Web (a): Text Descriptions 
24 Multimedia (d): Video 
Descriptions 
31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

1.1: Non-text Content 
1.2.1: Audio-only and Video-only 
(Prerecorded) 

18. 18. Synchronized Media 
(Captions) 

22 Web (b): Synchronized 
Alternatives 
24 Multimedia (c): Captions 
31 FPC (c): Use Without Hearing 

1.2.2: Captions (Prerecorded) 
1.2.4: Captions (Live) 

19. Synchronized Media 
(Descriptions) 

22 Web (b): Synchronized 
Alternatives 
24 Multimedia (d): Video 
Descriptions 
31 FPC (a): Use Without Vision 
31 FPC (b): Use with Low Vision  

1.2.3: Audio Description or Media 
Alternative (Prerecorded) 
1.2.5: Audio Description 
(Prerecorded) 

20. Forms 21 SW (a): Keyboard Accessibility 
21 SW (l): Forms 
22 Web (n): Labels for Forms 
31 FPC (a): Use without Vision 
31 FPC (b): Use with Low Vision 

1.3.1: Info and Relationships  

21. 21. Focus (Revealing 
Hidden Content) 

21SW (a): Keyboard Accessibility  
31 FPC (a): Use Without Vision 
31 FPC (b): Use With Low Vision 

2.4.3: Focus Order 
3.2.2: On Input 

22. Alternative Accessible 
Version 

22 Web (k): Alternative Versions Conformance requirement #1: 
conforming Alternate version 
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Section 508 (cross-reference table) 
Para. Name Baseline test 
21 SW (a) Keyboard Accessibility 1. Inline Elements 

20. Forms 
21. Focus (Revealing Hidden Content) 

21 SW (b) Built-in Accessibility Features 23. Security and Protection 
21 SW (c) Visual Focus N/A 
21 SW (d) Role, Name, State 6. Document Language 
21 SW (e) Bitmap images N/A 
21 SW (f) Input text N/A 
21 SW (g) OS Individual display attributes N/A 
21 SW (h) Animation 17. Video (Descriptions) 
21 SW (i) Color Dependence N/A 
21 SW (j) Variety of color selections N/A 
21 SW (k) Blinking objects  9. Flashing (Reserved) 
21 SW (l) Forms 20. Forms 
22 Web (a) Text Descriptions 13. Images and Other Objects 

16. Audio (Transcripts) 
17. Video (Descriptions) 

22 Web (b) Synchronized Alternatives 18. Synchronized Media (Captions) 
19. Synchronized Media (Descriptions) 

22 Web (c) Color Dependence 14. Color and Other Sensory Characteristics 
22 Web (d) Readable Style Sheets N/A 
22 Web (e) Redundant text links on server-side 

image maps 
N/A 

22 Web (f)  Client side not server side N/A 
22 Web (g) Row and Column Headers 10. Data Tables (Headers) 

11. Data Tables (Cell-Header Association) 
22 Web (h) Associate Data With Headers 10. Data Tables (Headers) 

11. Data Tables (Cell-Header Association) 
22 Web (i) Descriptive Frame Titles N/A 
22 Web (j) No flickering Interface components 9. Flashing (Reserved) 
22 Web (k) Alternative Versions 22. Alternative Accessible Version 
22 Web (l) Functional Text for Scripts N/A 
22 Web (m) Plug-ins N/A 
22 Web (n) Labels for Forms 20. Forms 
22 Web (o) Method to Skip Repetitive Links N/A 
22 Web (p) Time out notification N/A 
24 Multimedia 
(c) 

Captions 18. Synchronized Media (Captions) 

24 Multimedia 
(d) 

Video Descriptions 17. Video (Descriptions) 
19. Synchronized Media (Descriptions) 
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Para. Name Baseline test 
31 FPC (a) Use Without Vision 1. Inline Elements 

2. Reading Order 
3. Document Title (Filename) 
4. Headings 
5. Section Language 
6. Document Language 
7. Links and User Controls 
8. Lists 
12. Running Headers, Footers, and Watermarks 
14. Color and Other Sensory Characteristics 
17. Video (Descriptions) 
19. Synchronized Media (Descriptions) 
20. Forms 
21. Focus (Revealing Hidden Content) 
23. Security and Protection 

31 FPC (b) Use With Low Vision 1. Inline Elements 
2. Reading Order 
3. Document Title (Filename) 
4. Headings 
5. Section Language 
6. Document Language 
7. Links and User Controls 
8. Lists 
14. Color and Other Sensory Characteristics 
15. Color (Contrast) 
17. Video (Descriptions) 
19. Synchronized Media (Descriptions) 
20. Forms 
21. Focus (Revealing Hidden Content) 
23. Security and Protection 

31 FPC (c) Use Without Hearing 16. Audio (Transcripts) 
18. Synchronized Media (Captions) 

31 FPC (d) Use With Limited Hearing N/A 
31 FPC (e) Use Without Speech N/A 
31 FPC (f) Use With Physical Limitations 1. Inline Elements 

2. Reading Order 
4. Headings 
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WCAG 2.0 (cross-reference table) 
Note: 
The following table is for reference only. The baseline tests align with, but do not necessarily 
cover WCAG 2.0 AA completely. Following the tests should not be considered equitable to 
WCAG conformance. 
No. Name Baseline test 
1.1.1  Non-text Content 13. Images and Other Objects 

16. Audio (Transcripts) 
17. Video (Descriptions) 

1.2.1 Audio-only and Video-only 
(Prerecorded) 

16. Audio (Transcripts) 
17. Video (Descriptions) 

1.2.2  Captions (Prerecorded) 18. Synchronized Media (Captions) 
1.2.3  Audio Description or Media Alternative 

(Prerecorded) 
19. Synchronized Media (Descriptions) 

1.2.4  Captions (Live) 18. Synchronized Media (Captions) 
1.2.5  Audio Description (Prerecorded) 19. Synchronized Media (Descriptions) 
1.3.1  Info and Relationships 1. Inline Elements 

4. Headings 
8. Lists 
10. Data Tables (Headers) 
11. Data Tables (Cell-Header Association) 
20. Forms 

1.3.2  Meaningful Sequence 2. Reading Order 
12. Running Headers, Footers, and Watermarks 

1.3.3  Sensory Characteristics 14. Color and Other Sensory Characteristics 
1.4.1  Use of Color 13. Images and Other Objects 

14. Color and Other Sensory Characteristics 
1.4.2  Audio Control N/A 
1.4.3  Contrast (Minimum) 15. Color (Contrast) 
1.4.4  Resize text 23. Security and Protection 
2.1.1  Keyboard 1. Inline Elements 
2.1.2  No Keyboard Trap N/A 
2.2.1  Timing Adjustable N/A 
2.2.2  Pause, Stop, Hide N/A 
2.3.1  Three flashes or below threshold 9. Flashing (Reserved) 
2.4.1  Bypass Blocks N/A 
2.4.2  Page Titled 3. Document Title (Filename) 
2.4.3  Focus Order 2. Reading Order 

21. Focus (Revealing Hidden Content) 
2.4.4  Link Purpose (In Context):  7. Links and User Controls 
2.4.5  Multiple Ways N/A 
2.4.6  Headings and Labels N/A 
2.4.7  Focus Visible N/A 
3.1.1  Language of Page 6. Document Language 
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No. Name Baseline test 
3.1.2  Language of Parts 5. Section Language 

6. Document Language 
3.2.1  On Focus N/A 
3.2.2  On Input 21. Focus (Revealing Hidden Content) 
3.2.3  Consistent Navigation N/A 
3.3.1  Error Identification N/A 
3.3.2  Labels or Instructions N/A 
3.2.4  Consistent Identification N/A 
3.3.4  Error Prevention (Legal, Financial, 

Data) 
N/A 

4.1.1 Parsing N/A 
4.1.2  Name, Role, Value N/A 
N/A Conformance requirement #1: 

conforming Alternate version 
22. Alternative Accessible Version 

N/A Conformance Requirement #2: Full 
Pages 

N/A 

N/A Conformance Requirement #3: 
Complete Process 

N/A 

N/A Conformance requirement #4: only 
accessibility ways 

N/A 

N/A Conformance requirement #5: non-
interference 

23. Security and Protection 
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Attachment B - Flashing Content Test Advisory Notes 
Agencies must include an evaluation of flashing/blinking content in their test processes. However, as of 
the publication of the current version of the tests, there is no agreed-upon testing method. The test 
number 9 is reserved for a future version of this document when an agreed-upon test process will be 
included. The following are advisory notes relating to tests of flashing content. 

Why to Include a Flashing Content Test in a Test Process 
Even though there is no baseline, there are two primary reasons to include a test: the Section 508 law, 
and the risk of injury to users. 

The Section 508 standards require: 

§ 1194.21 Software applications and operating systems (k) Software shall not use flashing or 
blinking text, objects, or other components having a flash or blink frequency greater than 2 Hz 
and lower than 55 Hz. 

§ 1194.22 Web-based intranet and internet information and applications. (j) Pages shall be 
designed to avoid causing the screen to flicker with a frequency greater than 2 Hz and lower than 
55 Hz. 

The standards are in place as an attempt to reduce the likelihood of causing a seizure in a user with 
photosensitive epilepsy. It is therefore incumbent on agencies to apply due diligence to try to lower the 
likelihood of causing injury. 

Note: 
WCAG 2.0 also includes two related success criteria: 

2.2.2 Pause, Stop, Hide 

2.3.1 Three Flashes or Below Threshold 

The WCAG 2.0 Web site contains advice, commentary, and links to further information relating to the 
above success criteria that may be useful to consult when developing a streamlined test process. 

Why There is No Baseline Test for Flashing 
Despite exhaustive analysis efforts of DHS and SSA staff during the creation of the tests for Software & 
Web Accessibility, the precursor document for this baseline, a reliable, repeatable method to determine 
the number of flashes or blinks per second could not be found or established by the time of publication. 
A resolution must be found. There are many candidate methods to try, and it may be possible to create 
a software tool that can be accepted in the future. Candidate methods that have already been studied 
included: 

• Seeking the code from developers to show the programmed cycles per second. This test is 
considered as too advanced for most testers (cycle values have to be translated through formulas to 
get a Hz value). Further, other program and operating system functions can slow or speed up a 
programmed value to something that differs from the intended value (in our analysis, the majority 
showed flash rates that differed to the code). 

• A tester visually following the flashing, along with some counting aid (counting in the head "one 
thousand two one thousand" etc., using a stopwatch or countdown timer, using a metronome, and 
other methods). Each test involving human perception has its limitations and brings up inter-tester 
and intra-tester reliability questions. 
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• Using a software tool to blink at a known rate and placing it next to the flashing content to visually 
compare rates. Although this was promising, the ability of users varied in their capability of making 
measurements. After about 2.5 Hz, the testers could not reliably track both flashing objects. Further, 
getting the tool to blink at the desired rate on different computers was problematic. 

• Using a software tool to capture and analyze the content displayed on screen. The tools proved 
unreliable, in part due to the mismatch between sampling frequency and the screen refresh rate. 
Interference can occur when flashes are in the process of being 'drawn' on the screen at the same 
time as the sampling is taking place. 

• Using a video camera to capture the screen. This is considered a cumbersome test for general use, 
and it is subject to the same interference problems as with the screen capture software. 

Requirement and Draft Rationale 
Requirement 

Sections(s) of the document should not flash at or above 3Hz. 

Note: 
Section 508 sets limits at 2Hz, but WCAG, produced later than Section 508, revises that figure to 
3Hz based on research. It is likely that the Section 508 refresh will adopt the 3Hz figure, and so 
that requirement is adopted in the baseline. 

Rationale 
The following is advisory only. It will be finalized in future versions of this document when an agreed-
upon test process is released. 

Rationale 
[All Documents] 

 

…technical aspects A flashing / blinking component is one that is set to turn on and off 
continuously. The component can be anything on the screen, such as a 
piece of text, an indicator, a section of the screen, or the whole screen.  

…effects on 
accessibility 

A component that flashes or blinks in the visual field can cause adverse 
reactions in people who have photosensitive epilepsy. The size, intensity 
and duration that causes seizures varies from individual to individual.  

…consequences It is well established that objects flickering in the frequency range from 3Hz 
to 55Hz (from three times to 55 times per second) should be avoided. 

…benefits By avoiding flickering components in the specified range, the risk of 
inducing seizures is significantly reduced. 
Notes: 

• Scrolling ('marquee') text may cause a flashing effect under certain 
circumstances. 

• At flash rates approaching and above 55Hz, flashing can be 
imperceptible to the naked eye (the component(s) will look like they 
have a steady state). For this reason there is no test that deals with 
the higher cut-off point of 55Hz. 

…rationale Summary Summary: 
A component that flashes or blinks in the visual field can cause adverse 
reactions in people who have photosensitive epilepsy. It is well established 
that objects flickering in the frequency range from 3Hz to 55Hz should be 
avoided. 
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How to Report on Flashing Content 
When developing test processes and reporting results agencies must include a test related to flashing, 
even though there is no baseline test. 

• Results of tests should indicate the test method used. 
• Results of tests for flashing can be accepted by individual agencies at their discretion. 
• Agencies who adopt the baseline tests and share results with one another cannot reject another 

agency's test results just because they do not accept the methods for testing flashing content. 
Agencies can reject the flashing results, but will accept the remainder of the test results, until a reliable 
baseline test is chosen. 
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Attachment C – Adobe Acrobat XI and Acrobat DC 
Professional Accessibility Full Check 
Each check in the Accessibility Full Check is listed in the following table. Notes are provided on when 
and to what extent a check in the Accessibility Full Check relates to the Baseline Tests. 

Accessibility 
Full Check 

Applicable, NA, 
Must be used in 
conjunction with 
manual test 

Related 
Baseline Test  
(begins page #) 

Notes about Accessibility Full Check 

Document: 
“Accessibility 
permission flag” 

Applicable Security and 
Protection, #23, 
p.66  

If “Accessibility permissions flag” fails, then content 
copying for assistive technology is not allowed and the 
document fails Baseline #23. 

Document: 
“Image-only 
PDF” 

Conjunction Test 13 “Images 
and Other 
Objects.” p.42 

The Accessibility Full Check for “Image-only PDF” 
checks whether fonts are present (File > Properties > 
Fonts). If fonts are present, then the document 
contains electronic text. This check cannot verify 
accuracy or whether the text is a result of conversion 
from an electronic document or OCR of a scanned 
document. 

Document: 
“Tagged PDF” 

Applicable Testing 
preconditions, 
p.11 

In order to perform the Baseline Tests, the document 
must be tagged. To check for “Tagged PDF” in Adobe 
Acrobat XI and Acrobat DC Pro, open the Document 
Properties (File > Properties > Description) or run the 
Accessibility Full Check. If “Tagged PDF: No” is found 
in Document Properties or if “Tagged PDF” fails in the 
Accessibility Full check, then the PDF is not tagged. 
Guidance on handling untagged PDF documents 
should be included as part of a testing precondition for 
any Test Process. 

Document: 
“Logical Reading 
Order” 

Conjunction Reading Order, 
#2, p.17  

The Accessibility Full Check has a check for “Logical 
Reading Order” which always needs a manual check. 
Perform the manual checks to see whether the 
programmatic reading order matches the visual/logical 
reading order. 

Document: 
“Primary 
language” 

Conjunction Document 
Language, #6, 
p.27 

The Accessibility Full Check for “Primary language” 
will check whether the Document Language was left 
blank in Document Properties. Perform the manual 
checks to ensure that the selected language matches 
the intended and predominant language. 

Document: “Title”  Conjunction  Document Title 
(Filename), #3, 
p.20  

The Accessibility Full Check for Document “Title” 
checks whether the document “Title” set in Document 
Properties will display in the Windows Title Bar. While 
it is a good practice to set other relevant attributes and 
information fields (such as document title, author, 
subject matter, keywords / tags, etc.) in Document 
Properties, this check is beyond the Baseline Tests. 
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Accessibility 
Full Check 

Applicable, NA, 
Must be used in 
conjunction with 
manual test 

Related 
Baseline Test  
(begins page #) 

Notes about Accessibility Full Check 

Document: 
“Bookmarks”  

Not Applicable Headings, #4, 
p.22 

The Accessibility Full Check checks for the presence 
of “Bookmarks”. “Bookmarks” may assist in 
navigation; however, they are not a substitute for 
Headings.  

Document: 
“Color contrast” 

Conjunction Color (Contrast), 
#15, p.47 

The Accessibility Full Check has a check for Color 
Contrast, which always needs a manual check. 
Perform the manual checks to verify. 

Page Content: 
“Tagged content” 

Conjunction Reading Order, 
#2, p.17 

If Page Content: “Tagged content”, “Tagged 
multimedia”, or Forms: “Tagged form fields” fails, then 
meaningful content is not tagged or decorative content 
is not set to Artifact. 
If Page Content: “Tagged content”, “Tagged 
multimedia”, and Forms: “Tagged form fields” passes, 
then perform manual checks to verify that meaningful 
content is not set to Artifact.  

Page Content: 
“Tagged 
annotations” 

Conjunction Reading Order, 
#2, p.17 

The Accessibility Full Check has a check for Page 
Content “Tagged annotations,” which fails if links are 
not correctly tagged. If links are not correctly tagged, 
then the “Tab order” may not match the visual/logical 
order. Perform the manual checks to verify. 

Page Content: 
“Tab order” 

Conjunction Reading Order, 
#2, p.17 

The Accessibility Full Check “Tab order” checks the 
“Tab order” setting in Page Properties. The check fails 
if the “Tab order” is unspecified in Page Properties, 
but cannot determine whether the programmatic tab 
order matches the visual/logical order. Perform the 
manual checks.  

Page Content: 
“Character 
encoding” 

Not Applicable Section 
Language, #5, 
p.25 
Document 
Language, #6, 
p.27 

The Accessibility Full Check has a check for 
“Character encoding” to flag fonts that, while visually 
correct, may be incorrectly coded. This is important for 
technologies such as screen readers that convert this 
text into speech. When authors do not use the correct 
Unicode fonts for languages, text may not read 
properly or at all.  

Page Content: 
“Tagged 
multimedia” 

Conjunction Reading Order, 
#2, p.17 

If Page Content: “Tagged content”, “Tagged 
multimedia”, or Forms: “Tagged form fields” fails, then 
meaningful content is not tagged or decorative content 
is not set to Artifact. 
If Page Content: “Tagged content”, “Tagged 
multimedia”, and Forms: “Tagged form fields” passes, 
then perform manual checks to verify that meaningful 
content is not set to Artifact. 

Page Content: 
“Screen flicker” 

N/A Flashing 
(Reserved), #9, 
p.33 

See Attachment B - Flashing Content Test Advisory 
Notes. 
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Accessibility 
Full Check 

Applicable, NA, 
Must be used in 
conjunction with 
manual test 

Related 
Baseline Test  
(begins page #) 

Notes about Accessibility Full Check 

Page Content: 
“Scripts” 

Applicable Testing 
preconditions, 
p.11 

The Accessibility Full Check will flag the presence of 
“Scripts” in a document. Adding programmed 
formatting to a document effectively turns it into a 
software application. Software applications should be 
tested using appropriate software testing methods. 
Therefore, this test process does not apply. 

Page Content: 
“Timed 
responses” 

N/A N/A  

Page Content: 
“Navigation links” 

N/A N/A The Accessibility Full Check “Navigation links” is a 
check of repetitive identical links. The Accessibility 
Full Check advises that if the same links appear on 
each page of the document, also include a “skip 
navigation" link. 
This is a requirement and solution for web, but not 
part of the Baseline Tests for Documents.  

Forms: “Tagged 
form fields” 

Conjunction Reading Order, 
#2, p.17 

If Page Content: “Tagged content”, “Tagged 
multimedia”, or Forms: “Tagged form fields” fails, then 
meaningful content is not tagged or decorative content 
is not set to Artifact. 
If Page Content: “Tagged content”, “Tagged 
multimedia”, and Forms: “Tagged form fields” passes, 
then perform manual checks to verify that meaningful 
content is not set to Artifact. 

Forms: “Field 
descriptions” 

Conjunction Forms, #20, p.59 If Forms “Field descriptions” fails, then tooltips were 
left blank and labels, instructions, directions and cues 
necessary to complete a form are not 
programmatically or textually associated with their 
respective input control and the document fails 
Baseline Requirement #20. 
If Forms Fields descriptions Pass, then perform the 
manual checks to verify that the tooltip is appropriate 
for each field. Be sure to check every field, not just the 
ones flagged by the automated checker, because 
incorrect tooltips will not be flagged. 

Alternate Text: 
“Figures 
alternate text” 

Conjunction Images and 
Other Objects, 
#13, p.42 

If “Figures alternate text” fails, then images or objects 
do not contain alternative text or decorative images 
are not set to Artifact and the document fails Baseline 
Requirement #13. 
If “Figures alternative text” passes, perform the 
manual checks to verify that the alt text is appropriate 
for each image. Be sure to check every image, not 
just the ones flagged by the Accessibility Full Check, 
because incorrect alt text or meaningful images and 
objects set to Artifact will not be flagged.  
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Accessibility 
Full Check 

Applicable, NA, 
Must be used in 
conjunction with 
manual test 

Related 
Baseline Test  
(begins page #) 

Notes about Accessibility Full Check 

Alternate Text: 
“Nested alternate 
text” 

N/A N/A The Accessibility Full check “Nested alternate text” 
looks for nested elements in the Tags Pane that have 
associated alternate text. This is not part of the 
Baseline Tests for Documents. The Baseline Test for 
alternate text is only concerned that Images and Other 
Objects do have alternate text, not whether additional 
content contains alternate text. 

Alternate Text: 
“Associated with 
content” 

N/A N/A The Accessibility Full Check checks for alternative text 
not “Associated with content”. This is not part of the 
Baseline Tests. The Baseline test for Images and 
Other Objects checks whether content has associated 
alternative text.  

Alternate Text: 
“Hides 
annotation” 

N/A N/A This is contradictory to the Baseline Tests for 
Documents which allows a linked image to contain the 
link name in the alternate text. 

Alternate Text: 
“Other elements 
alternate text “ 

Conjunction Images and 
Other Objects, 
#13, p.42 

If “Other elements alternate text“ fails, then images or 
objects do not contain alternative text or decorative 
images are not set to Artifact and the document fails 
Baseline Requirement #13. 
If “Other elements alternative text” passes, perform 
the manual checks to verify that the alt text is 
appropriate for each image. Be sure to check every 
image, not just the ones flagged by the Accessibility 
Full Check, because incorrect alt text or meaningful 
images and objects set to Artifact will not be flagged. 

Tables: “Rows” N/A N/A This rule checks whether each TR in a table is a child 
of Table, THead, TBody, or TFoot. 

Tables: TH and 
TD  

N/A N/A  TH and TD are children of TR. 

Tables: 
“Headers”  

N/A  Data Tables 
(Headers), #10, 
p.34 

The Accessibility Full Check has a test for Table: 
“Headers”. However, this check only looks at the first 
cell of the table. Therefore, the test is unreliable. 
Perform the manual tests to verify.  

Tables: 
“Regularity”  

N/A Data Tables 
(Cell-Header 
Association), 
#11, p.37 

The Accessibility Full Check has a test for Table: 
“Regularity”. However, this check is not a reliable find 
for complex data tables, nor is it a test for 
programmatically associated data cells. Perform the 
manual checks to verify. 

Tables: 
Summary  

N/A Data Tables 
(Headers), #10, 
p.34 

The Accessibility Full Check includes Table: 
Summary, which is a good practice, but not part of the 
Baseline test. 
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Accessibility 
Full Check 

Applicable, NA, 
Must be used in 
conjunction with 
manual test 

Related 
Baseline Test  
(begins page #) 

Notes about Accessibility Full Check 

Lists: “List items” N/A Lists, #8, p.31 The Accessibility Full Check for “List items” reports 
whether each LI is a child of L. If “List items” fails, the 
structure of the list is incorrect. A List tag must contain 
List Item tags. However, this check cannot verify that 
visually apparent lists are programmatically identified. 
Perform the manual checks to determine whether lists 
are programmatically identified. 

Lists: “Lbl and 
LBody” 

N/A Lists, #8, p.31 The Accessibility Full Check for “Lbl and LBody” under 
Lists reports whether List Item tags only contain Label 
tags and List Item Body tags. While this is a common 
practice, it is not required for an accessible list 
structure. 

Headings: 
“Appropriate 
nesting” 

N/A Headings, #4, 
p.22 

The Accessibility Full check for “Appropriate nesting” 
of headings looks for skipped heading levels. This 
check is beyond the Baseline Tests. However, it might 
be worth informing authors that using a sequentially 
ordered hierarchy is a best practice. 
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Attachment D – Color contrast Analyzers 
The following tools can be used to compare color contrast: 

•  WebAim Color Contrast Anaylzer (http://webaim.org/resources/contrastchecker/) 
• The Paciello Group Colour Contrast  Analyser 

(http://www.paciellogroup.com/resources/contrastAnalyser) 
• Colour Contrast Check (http://snook.ca/technical/colour_contrast/colour.html) 
 

http://webaim.org/resources/contrastchecker/
http://sharepoint.ba.ssa.gov/dcs/oses/DUAPS/ASB/ASBPAL/EDTPAL/AED/PDF/Draft/The%20Paciello%20Group%20Colour%20Contrast%20Analyser%20%20(http:/www.paciellogroup.com/resources/contrastAnalyser)
http://sharepoint.ba.ssa.gov/dcs/oses/DUAPS/ASB/ASBPAL/EDTPAL/AED/PDF/Draft/The%20Paciello%20Group%20Colour%20Contrast%20Analyser%20%20(http:/www.paciellogroup.com/resources/contrastAnalyser)
http://sharepoint.ba.ssa.gov/dcs/oses/DUAPS/ASB/ASBPAL/EDTPAL/AED/PDF/Draft/Colour%20Contrast%20Check%20(http:/snook.ca/technical/colour_contrast/colour.html)
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